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1 概要 

REVOCAP_PrePostは、マルチ力学シミュレータ REVOCAPの一部として、メッシュ生

成、解析条件の設定といったプレ処理、および計算結果の可視化といったポスト処理を行

う、大規模アセンブリ構造の連成解析対応のプレポストプロセッサである。PC上で単体動

作するプログラムである。 

REVOCAP_PrePostのプレ処理機能では、形状データ（CADデータ）を受け取り、解析

用のメッシュを生成し、解析条件・境界条件などを設定して、解析モデルを作成する。こ

の一連の作業を 3D画面上でインタラクティブに、形状やメッシュの性質、境界条件などを

確認しながら実現する。 

また、REVOCAP_PrePost のポスト処理機能では、ソルバが計算した結果を読み込んで

3D画面の中で可視化し、結果のコンター表示、断面表示等を行う。インタラクティブに視

点を動かし、拡大、縮小などを行うことで、ユーザーが計算結果を評価することを援助す

る。 
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2 動作環境 

REVOCAP_PrePostは、デスクトップの PC上で、解析者または設計者が利用すること

を想定している。 

動作環境は以下のとおり。 

 計算機 : PC 互換機 

 OS : Windows XP / Windows Vista / Windows 7 / Linux 

Windowsはそれぞれ 32bitおよび 64bit環境での動作を確認している。動作確認してい

る Linuxのディストリビューションは以下のとおり。 

 Ubuntu 8.04 以降 

 OpenSUSE 11.3 

Mac OS X(Snow Leopard 以降)については一部の機能を除いて動作報告はあるが、現在

のところ動作の保証はしていない。 
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3 開発言語・利用しているライブラリ 

 アプリケーション起動部、GUI部はスクリプト言語 Ruby(Ver.1.8.7および

Ver.1.9.2) http://www.ruby-lang.org/ で実装している 

 メッシュ処理部、可視化処理部は C++で実装している 

 GUIコンポーネントは FXRuby(Ver.1.6.20)を利用している

http://www/fxruby.org/ 

 3D可視化モジュールは OpenGL を利用している http://www.opengl.org/ 

 3D可視化モジュールの拡張機能として GLEWを利用している

http://glew.sourceforge.net/ 

 FXRuby 上の可視化には ruby-opengl(0.60) を利用している 

http://ruby-opengl.rubyforge.org/ 

 CADカーネルは OpenCASCADE(Ver.6.3.0)を利用している

http://www.opencascade.org/ 

 4面体メッシュ生成は ADVENTURE_TetMesh(Ver.0.91)を利用している 

http://adventure.q.t.u-tokyo.ac.jp/ 

 Rubyスクリプトの実行ファイルへの変換は exerb(Ver.5.3.0)を利用している 

http://exerb.sourceforge.jp/ 

 ネットワーク上のデータ転送には Net::SSH を利用している 

http://net-ssh.rubyforge.org/ 

 Net::SSH は OpenSSL を利用している http://www.openssl.org/ 

それぞれの配布条件については、同梱のライセンスファイルをご覧ください。 

http://www.ruby-lang.org/
http://www.ruby-lang.org/
http://www/fxruby.org/
http://www/fxruby.org/
http://www.opengl.org/
http://glew.sourceforge.net/
http://ruby-opengl.rubyforge.org/
http://www.opencascade.org/
http://adventure.q.t.u-tokyo.ac.jp/
http://adventure.q.t.u-tokyo.ac.jp/
http://exerb.sourceforge.jp/
http://exerb.sourceforge.jp/
http://net-ssh.rubyforge.org/
http://www.openssl.org/


10 

 

4 インストールと起動方法 

4.1 インストールの準備 

Windows環境ではインストーラーが提供される。この場合、以下の準備は不要である。 

Linux上で REVOCAP_PrePost を利用する場合、Windows上でスクリプトから利用す

る場合、および REVOCAP_PrePostの開発・拡張を行う場合は、REVOCAP_PrePostの

内部で利用しているツール、ライブラリ類をあらかじめインストールしておく必要がある。 

Windows(32bit版)の場合 

まず、スクリプト言語 Rubyをインストールする。公式サイトからダウンロードし、パッ

ケージマネージャなどを利用して手動で上記に挙げた Ruby言語の拡張ライブラリ 

 FXRuby 

 ruby-opengl 

 Net::SSH 

をインストールしてもよいが、これら一式がパッケージ化された Ruby Installer for 

Windows (http://rubyinstaller.org) を用いるのが便利である。 

REVOCAP_PrePostのメッシュ処理用の拡張ライブラリはソースコードに同梱されている

のでそれを利用する。自分でビルドするための方法は後述する。 

REVOCAP_PrePostが利用しているライブラリ 

 OpenCASCADE 

 GLEW 

をあわせてインストールし、PATHの設定を行って REVOCAP_PrePost から実行可能な状

態にしておく。 

REVOCAP_PrePostから呼び出されるプログラム 

 ADVENTURE_TetMesh 

 Gnuplot(http://www.gnuplot.info/) 

をインストールしておく。Gnuplotは必須ではないが、インストールされていればグラフ

の表示を行うときに自動的に呼び出される。 

Windows(64bit版)の場合 

Ruby 言語をインストールする。この場合は Ver.1.9.2 以降をインストールする。以下の

作業はWindows(32bit版)の時と同じであるが、拡張ライブラリの実行体はまだ提供されて

いない場合があるので、適宜自分で拡張ライブラリをソースコードからビルドする必要が

http://rubyinstaller.org/
http://www.gnuplot.info/
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ある。 

Linuxの場合 

それぞれのシステムのやり方（不明の場合は管理者に問い合わせてください）で以下の

ツール・ライブラリ類をインストールする。 

 Ruby 

 OpenCASCADE 

 GLEW 

また Ruby言語の拡張ライブラリとして、以下のものを gemなどの Rubyのパッケージ

マネージャなど使ってインストールする。 

 FXRuby 

 ruby-opengl 

 Net::SSH 

Linux上で REVOCAP_PrePost の拡張ライブラリをビルドする場合は、別途

REVOCAP_PrePostのメッシュ処理用の拡張ライブラリのインストールが必要である。こ

れについては後述する。 

REVOCAP_PrePostから呼び出されるプログラム 

 ADVENTURE_TetMesh 

 Gnuplot(http://www.gnuplot.info/) 

をインストールしておく。Gnuplotは必須ではないが、インストールされていればグラフ

の表示を行うときに自動的に呼び出される。 

4.2 インストール手順（Windowsインストーラーを利用す

る場合） 

インストール手順は 32bit版、64bit版共通である。setup.exeを実行すると、セットア

ップウィザードが立ち上がるので、その指示に従って進めていけばよい。 

http://www.gnuplot.info/
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図 4-1インストール画面 1 

メッセージを確認して、「次へ」を押す。 

 

図 4-2インストール画面２ 

インストール場所を確認して「次へ」を押す。 
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図 4-3インストール画面３ 

「次へ」を押してインストールを実行する。 

 

図 4-4インストール画面４ 

しばらく待つ。 
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図 4-5インストール画面５ 

正常に完了しました、というメッセージを確認する。 

4.3 インストール手順（スクリプトで実行する場合） 

インストールは配布される圧縮ファイルを展開して行う。GUIライブラリの制限により

フォルダ名に空白や日本語が含まれている場合は正常に動作しない場合があるので、空白

や日本語が含まれないようなフォルダに展開する。 

展開すると、以下のようなファイルとフォルダが生成される。 
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アプリケーション内部で使われる設定ファイルや画像ファイルも含まれているので、フ

ォルダの階層構造は変えてはいけない。 

最上位フォルダには exerbによって RubyスクリプトをWindows 用実行ファイルに変

換した REVOCAP_PrePost_XXX.exe (XXXは対応するソルバの名前) がある。 

bin ディレクトリの下は REVOCAP_PrePost から呼び出している外部ツールを配置する。

-+-AdvSolid                   ADVENTURE_Solid 用のプレポスト 

  +-bin                        外部プログラム、ランタイムライブラリ 

  | +-i386-mswin32             Windows 32bit 用のバイナリ、ランタイムライブラリ 

  | +-i686-darwin10            Mac OS X 用のバイナリ、ランタイムライブラリ（テスト用） 

  | +-i686-linux               Linux (intel 486 系 32bit) 用のバイナリ、ランタイムライブラリ 

  | +-x64-mswin64_100          Windows 64bit 用のバイナリ、ランタイムライブラリ 

  +-common                     REVOCAP_PrePost の共通描画クラス 

  +-data                       サンプルデータ 

  +-dialog                     REVOCAP_PrePost の共通ダイアログ 

  +-doc                        REVOCAP_PrePost のドキュメントクラス 

  +-Documents                  ドキュメント類 

  +-FFb                        FrontFlow/blue 用のプレポスト 

  +-FFbA                       FrontFlow/blueAcoustic 用のプレポスト 

  +-Fstr                       FrontSTR 用のプレポスト 

  +-icons                      アイコンなどの画像ファイル 

  +-lib                        Ruby ライブラリ 

  | +-fox16                    FXRuby スクリプト 

  | +-highline                 highline 

  | +-i386-mswin32             Windows 32bit 用の Ruby 拡張ライブラリ 

  | +-i686-darwin10            Mac OS X 用の Ruby 拡張ライブラリ（テスト用） 

  | +-i686-linux               Linux (intel 486 系 32bit) 用の Ruby 拡張ライブラリ 

  | +-net                      Net::SSH および Net::Sftp スクリプト 

  | +-x64-mswin64_100          Windows 64bit 用の Ruby 拡張ライブラリ 

  +-MeshGen                    メッシュ生成用のスクリプト 

  +-MeshIO                     メッシュ入出力用のスクリプト 

  +-RcapCoupler                REVOCAP_Coupler 用のプレポスト 

  +-RcapMagnetic               REVOCAP_Magnetic 用のプレポスト 

  +-TetMesh                    REVOCAP_Magnetic 用のプレポスト 

  +-tools                      REVOCAP_PrePost の共通ユーザインターフェイス 

  +-utils                      REVOCAP_PrePost の共通ツール 

  +-ADVENTURESolid.rb          ADVENTURE_Solid 用プレポスト定義スクリプト 

  +-FrontFlowBlue.rb           FrontFlow/blue 用プレポスト定義スクリプト 

  +-FrontFlowBlueAcoustic.rb   FrontFlow/blueAcoustic 用プレポスト定義スクリプト 

  +-FrontISTR.rb               FrontISTR 用プレポスト定義スクリプト 

  +-README.txt                 はじめに読むファイル 

  +-REVOCAPCoupler.rb          REVOCAP_Coupler 用のプレポスト定義スクリプト 

  +-REVOCAPMagnetic.rb         REVOCAP_Magnetic 用のプレポスト定義スクリプト 

  +-REVOCAP_PrePost.rb         REVOCAP_PrePost 起動用スクリプト 

  +-RevocapVisual.rb           REVOCAP_PrePost GUI 可視化アプリケーション起動ランチャクラ

ス 

  +-REVOCAP_Mesh-1.6.XX.tgz    メッシュ処理用拡張ライブラリ作成用のソースコード 

  +-REVOCAP_PrePost_AdvSolid.exe      ADVENTURE_Solid 用プレポストの Windows 版実行ファイ

ル 

  +-REVOCAP_PrePost_FFb.exe           FrontFlow/blue 用プレポストの Windows 版実行ファイル 

  +-REVOCAP_PrePost_FISTR.exe         FrontISTR 用プレポストの Windows 版実行ファイル 

  +-REVOCAP_PrePost_RcapCoupler.exe   REVOCAP_Coupler 用プレポストの Windows 版実行ファイ

ル 

  +-REVOCAP_PrePost_RcapMagnetic.exe  REVOCAP_Magnetic 用プレポストの Windows 版実行ファイ

ル 

  +-VERSION                    バージョン情報 
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Ruby言語の RUBY_PLATFORM 定数の値のサブディレクトリを作成し、そこに必要なバ

イナリ、ランタイムライブラリなどを配置する。REVOCAP_PrePostから呼びだしている

外部ツールについても、実行する環境に対応したファイルを配置する。 

libディレクトリの下は Ruby言語の拡張ライブラリを配置する。動作環境に依存する拡

張ライブラリは Ruby言語の RUBY_PLATFORM 定数の値のサブディレクトリを作成し、

そこに必要なファイルを配置する。 

4.4 起動方法（Windowsインストーラーを利用した場合） 

Windowsのプログラムメニューの CISSの下にプログラムが登録されているので、該当

するもの（対応するソルバによって複数実行ファイルがあることに注意する）をダブルク

リックする。 

4.5 Linux 版または Windows 版（スクリプトファイル）

の起動方法 

スクリプトから実行する場合は、 

ruby REVOCAP_PrePost.rb ソルバ名 

と実行する。例えば、FrontISTR 版のプレポストを実行する場合は 

ruby REVOCAP_PrePost.rb FrontISTR 

とする。ソルバ名.rb がプレポストの定義スクリプトである。以下のソルバ名について対

応している。ファイルシステム上の制限により空白や/（スラッシュ）を使わない標記にな

っていることに注意する。 

 FrontISTR 

 FrontFlowBlue 

 ADVENTURESolid 

 REVOCAPCoupler 

 REVOCAPMagnetic 

--ini=設定ファイル、--app=追加設定ファイル、のオプションを指定することができる。設

定ファイルについての詳細はエラー! 参照元が見つかりません。章の「エラー! 参照元が

見つかりません。」を参照のこと。また、--help オプションでオプションの説明、--version

でバージョン番号が表示される。 
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4.6 REVOCAP_PrePost が生成するログファイルと中間フ

ァイルについて 

REVOCAP_PrePostは Log Message Paneに出力した内容およびエラーが発生した場合

はそのエラーメッセージをログファイルに出力する。環境変数 TEMPが設定されている場

合 は そ の デ ィ レ ク ト リ （ Windows7 の 場 合 は 通 常

C:¥Users¥username¥AppData¥Local¥Temp である）の下に REVOCAP ディレクトリ

を作成し、環境変数が設定されていない場合はインストールしたディレクトリの下に tmp

ディレクトリを作成して、その場所に RevocapYYYYMMDDHHMMSS.log という形式の

ファイル名で（YYYYMMDDHHMMSS は年月日時分秒を表す）ログを保存する。メッシ

ュ生成などで中間ファイルを作成する場合はログを出力するディレクトリにさらにサブデ

ィレクトリを作成して中間ファイルを作成する。 

エラー報告をする場合はこのログファイルを添付していただきたい。
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5 拡張ライブラリのインストール 

REVOCAP_PrePost はRubyで実装されたGUI部とC++で実装されたメッシュ処理部

からなる。メッシュ処理部は Rubyの拡張ライブラリとして GUIから呼ばれる。ここでは

メッシュ処理部の拡張ライブラリをソースからビルドして Rubyの拡張ライブラリとして

インストールする方法を説明する。なお、配布されているソースコードにはWindows 版

およびその他の環境のライブラリを添付しているため、ここでの作業をしなくても実行で

きる。 

5.1 インストールの準備 

拡張ライブラリの内部で利用しているライブラリを準備する。付記しているバージョン

は、公開パッケージを作成した環境のものである。 

 OpenGL 

 GLEW 

 Ruby (32bit環境では Ver.1.8.7、64bit環境では Ver.1.9.2) 

 OpenCASCADE (Ver.6.3) 

 swig (Ver. 2.0.4) 

OpenGL はシステムで通常既にインストールされているものを利用すればよい。 

次にmakeプログラムで参照している環境変数を設定する。 

環境変数名 意味 

RUBYDIR Rubyがインストールされているディレクトリ 

RUBY19DIR Ruby Ver.1.9 がインストールされているディレクトリ 

CASROOT OpenCASCADEの標準ディレクトリ 

SWIGDIR swigがインストールされているディレクトリ 

PATH Rubyおよび swigの実行体のある場所を追加する 

5.2 対応しているコンパイラの準備 

 Microsoft Visual C++ 2010 

 g++ Ver. 4 

上記のコンパイラで動作確認している。Windows上で VisualStudioを用いたインスト

ール方法については省略する。以下では Linux 環境でインストールする方法を説明する。 
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5.3 Linux環境でのインストールの実行 

上記で説明したライブラリおよびコンパイラをあらかじめ準備しておく。 

REVOCAP_PrePost に同梱されている REVOCAP_Mesh-1.6.XX.tgz ファイルを適当

な場所で展開する。展開したディレクトリの OPTIONS ファイルに Makefile で使われ

る変数が定義されている。このファイルを自分の環境にしたがって編集し、makeを実行

する。RubyExtension ターゲットに拡張ライブラリのための設定がまとめられているの

で、 

$ make RubyExtension 

とする。lib/$(ARCH) ディレクトリに拡張ライブラリ 

 RevocapMesh.so 

 RevocapMeshGen.so 

 RevocapGL.so 

 RevocapIO.so 

 RevocapShape.so 

が作成されれば成功である。これらのファイルを REVOCAP_PrePost がインストール

されたディレクトリの lib/$(ARCH)ディレクトリにコピーする。
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6 画面構成と基本操作方法 

6.1 画面構成 

REVOCAP_PrePostの画面構成は下の図のようになっている。 

 

図 6-1 画面構成 

 Menu Bar : メニュー 

 Tool Bar : メニューの機能の中でよく使うものを呼び出すアイコンが並んでいる。 

 Tree View : 階層的にモデルの情報を表示する。複数のモデルを読み込んでいると

きは、階層の最上位が複数になる。 

 Custom Pane : TreeViewで選択された項目に連動して、モデルの情報を表示した

り、パラメータ類を設定したりするためのUIを表示するための領域。 

 3D View : モデルを 3D表示する領域。2Dのグラフなどを表示する場合もある。 

 Log Message Pane : ソフトウェアやシステムからのメッセージを表示する。 

6.2 メニューバー 

メニューバーからは以下のメニューを選択できる。対応するソルバによって若干のメニュ

ーの変更がある。 
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 File 

 Open Mesh メッシュを開く 

 Import CAD CADデータを開く 

 Open Result ソルバの出力ファイルを開く 

 Save Model モデルを保存する 

 Save Neutral ニュートラルファイルを作成する 

 Save Image 画像を保存する 

 Quit 終了する 

 View 

 Paralllel 平行投影による表示 

 Perspective 透視投影による表示 

 Front 正面を表示 

 Back 背面を表示 

 Left 左面を表示 

 Right 右面を表示 

 Top 上面を表示 

 Bottom 下面を表示 

 Fit 画面の中央に表示 

 Zoom マウスで選択した領域を表示する 

 Reset 初期表示状態に戻す 

 Init Pos 移動したオブジェクトの位置を戻す 

 Sync 他の画面をこの画面の視点に同期する 

 Clear 選択状態を解除する 

 Axis 座標軸の表示 

 Axis2D 座標軸の二次元の表示 

 Drawing 

 Surface メッシュのポリゴンを陰影をつけて表示 

 Grid メッシュのグリッド表示 

 Wireframe メッシュの要素の辺を表示 

 Edge メッシュの形状を特徴づける辺を表示 

 Rendering 陰影をつける 

 Antialiasing 描画をなめらかにする 

 Layout 

 Tile Horizontally 複数のビューを横に並べる 

 Tile Vertically 複数のビューを縦に並べる 

 Cascade 複数のビューを重ねる 
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 Toolbar ツールバーの表示、非表示 

 Help 

 About REVOCAP_PrePost バージョン情報等を表示する 

 Manual マニュアルを開く 

 Tutorial チュートリアルを開く 

6.3 ツールバー 

メニューバーにある一部の機能などが、ツールバーにあるアイコンから実行できる。  

 

6-2ツールバー 

ツールバーにあるアイコンの機能は、左から順に以下の通りである。  

 Open Mesh  

 Open Result  

 Parallel  

 Perspective  

 Front  

 Back  

 Left  

 Right  

 Top  

 Bottom  

 Zoom  

 Fit 

 Init Pos 

6.4 3D Viewの座標系 

REVOCAP_PrePostは 3D Viewにおいて、モデルを 3次元表示する。このときの座標系

は右手系である。OpenGL の座標系は右手系である。一部の 3次元可視化ソフトの中には

左手系のものもあるのでデータ変換の時などには注意する。 

6.5 メッシュ表示方法 

REVOCAP_PrePostはメッシュの表示方法として、 
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 ポリゴンを表示する Surfaceモード 

 面と辺の両方を表示する Gridモード 

 モデル表面の要素の辺を表示するWireframeモード 

 形状を特徴づける辺を表示する Edgeモード 

を切り替えることができる。 

 

図 6-3 メッシュの表示方法(Surfaceモード) 

 

図 6-4メッシュ表示の方法（Gridモード） 
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図 6-5 メッシュの表示方法(Wireframeモード) 

 

図 6-6 メッシュの表示方法(Edgeモード) 

Edgeモードでは面を水色と青色の 2重線で表され、体積領域を白もしくはグレーの線で

描かれる。このモードではレンダリングする量が減るために、高速に動作する。ただしマ

ウスによる面の選択は 2重線をクリックしなければならないので注意する。 

Surface表示する場合に Renderingを有効になっている場合は、Open GLのMaterial 

Colorが有効となり、陰影も表示される。通常は自動的に有効になる。 

CAD形状を表示するときはデフォルトで Surfaceモードになっており、プレ処理をする

場合はデフォルトでWireframeモードになっている。ランチャが呼び出すドキュメントご

とにデフォルトの表示方法は異なるので注意する。また、場合によってはいくつかの表示

モードを無効にしている場合もあるので注意する。（詳細は各ソルバ用プレポストのドキ

ュメントなどを参照） 
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6.6 マウス操作（面の選択、移動方法） 

モデルの表示後は、マウスの操作によって、回転（左ボタンドラッグ）、平行移動（右

ボタンドラッグ）、ズーム（中央ボタンスクロール）が可能となる。 表面のメッシュはマ

ウスで選択することで、3DViewの中で移動させることができる。 

3DView内に表示されているオブジェクトをクリックするとピンク色に表示が変わる。こ

れはこのオブジェクトが選択されていることを示している。 

 

図 6-7 面の選択方法（面が選択された状態） 

この選択状態から、マウスを左ボタンドラッグすると面を移動させることができる。 

 

図 6-8 面の選択方法（面を移動した状態） 

プレ処理の境界条件付与等の際には、このように面を選択することが必要である。一度

に複数の面を選択する場合は Shiftキーを押しながら選択を追加する面をクリックする。 

移動させたオブジェクトをすべて元の位置に戻すにはメニューから View ⇒ Init Pos 

を選択する。 
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体積領域を選択する場合も同様に目的のオブジェクトをクリックすると選択状態になり、

稜線がピンク色に変わる。複数選択の場合は Shiftキーを押しながらクリックする。 

選択状態を解除するには、メニューバーのの「View」メニューから Clearを選択する。 

6.7 マウスで移動した面をもとに戻す 

移動させた面等の描画オブジェクトをすべて元の位置に戻すにはメニューから View ⇒ 

Initialize Position を選択する。 

 

図 6-9位置をもとに戻す 

コントロールキーと Iを同時に押す、またはツールバーの アイコンをクリックするこ

とでも実現できる。 

6.8 ビューの切り替え 

メニューバーにある「View」メニューのプルダウンメニューから、3DViewの中の表示

の仕方を変更することができる。 

遠近処理の有り無しは、Perspective、Parallelを選択して切り替える。視点方向の変更

(Front、Back、Left、Right、Top、Bottom)は、ツールバーの座標軸が書かれているアイ
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コンのボタンでも変更できる。Zoomを選択するとマウスのポインタが範囲指定の形に変わ

るので、拡大したい領域を選択するとその部分が拡大される。Resetはオブジェクトを移動

して表示範囲をはみ出してしまった場合などに、オブジェクト表示範囲の再設定を行う。

Fitを選択すると、モデルを画面の中央に移動する。 

Axisは座標軸の 3次元表示を行う。3DViewの原点に座標軸を表示する。視点を移動さ

せると座標軸も同時に動く。Axis2Dは座標軸の２次元表示を行う。3DViewの左下に座標

軸の向きが表示される（動かない）。 

6.9 視点の同期 

3D View画面の中に複数のモデルが表示されているときに、現在表示中の画面の視点で

他の画面の視点を合わせることができる。メニューバーにある「View」メニューのプルダ

ウンメニューから Syncを選択する。 

 

図 6-10視点を同期する 

これを用いると、例えばメッシュ生成用の画面の視点とプレ処理用の画面の視点を一致

させることができる。 
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6.10 ツリー画面での選択 

TreeViewにメッシュの情報が階層的に表示されている場合、TreeViewにおける体積領

域や面に対応する項目をマウスで選択すると、同時に 3DViewでの対応するオブジェクト

も選択状態になり、ピンク色に表示が変わる。このように選択状態になった場合にも

3DViewでクリックして選択したのと同様に、境界条件の設定を行うことができる。 

ただしこの場合は 3DViewの中でドラッグして移動させることはできない。 

6.11 画面の保存 

Fileメニューより SaveImageを選択すると、3DViewに表示されている内容を画像ファ

イルに保存することができる。対応しているフォーマットはビットマップファイル(bmp)、

JPEG形式(jpg)、および PortableNetworkGraphics 形式(png)である
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7 REVOCAP_PrePost メッシュ生成マニュアル 

7.1 概要 

REVOCAP_PrePost でのメッシュ生成機能では、CAD データの読み込みと三角形表面

パッチデータの生成は OpenCASCADE を用いて独自に処理を行い、三角形パッチから四

面体のメッシュ生成には ADVENTURE プロジェクトの ADVENTURE_TetMesh を呼

び出している。それ以外の機能、表面抽出、面の向きの反転、ギャップ修正などは 

REVOCAP_PrePost の内部で処理をしている。 

7.2 操作手順 

以下の手順に従ってメッシュを生成する。 

(1) 形状ファイル（CADファイルまたは三角形パッチファイル）の読み込み（複数材料

モデルの場合はさらに形状ファイルを追加） 

(2) パッチの修正（解像度を変えて再生成、パッチ面の裏返し、ギャップの修正など） 

(3) ADVENTURE_TetMesh パラメータの設定（基準長さ、節点密度制御） 

(4) メッシュ生成 

7.3 形状ファイル（CADファイルまたは三角形パッチファ

イル）の読み込み 

REVOCAP_PrePost では次の形状ファイルを読み込むことができる。 

 ADVENTURE_Tripatch 形式（pch ファイルまたは pcm ファイル） 

 IGES 形式 

 STEP 形式 

 STL 形式 

メニューから File⇒Import CAD を選択して、File Filter でファイル形式を選択してか

らファイルを読み込む。 

形状ファイルを読み込むと、TreeViewにMeshGeneration の項目ができ、その下に形

状データの項目ができる。さらにその下に形状ファイルごとの設定項目が現れる。 

ツリーの形状データの項目を選択すると形状ファイルを追加するフォームが表示される。
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このフォームから形状データを追加すると、TreeViewの形状データの下に複数の形状デー

タがぶら下がる。 

 

図 7-1形状ファイル読み込み 
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図 7-2形状データの追加フォーム 
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図 7-3複数形状ファイル読み込み後 

7.4 パッチ再生成 

CAD データを三角形パッチに変換する際のパラメータを変更してパッチを再生成する

ことができる。三角形パッチを細かくするには増分パラメータを小さくする。増分パラメ

ータはモデルの大きさの相対値で与える。偏差の値で三角形パッチの最大偏差を制御する

こともできる。 

また、OpenCASCADE の内部ルーチンを使っての形状データが閉じているかどうか、妥

当かどうかのチェックを行うこともできる。 
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図 7-4パッチ再生成 

7.5 パッチ情報 

ここでは、閉じていない辺や、面積の小さい三角形を探したり、選択されている三角形

を裏返したりすることができる。 

メッシュ生成に失敗する場合に、ここでの情報をもとに三角形パッチを修正するとメッ

シュ生成に成功する場合がある。 
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図 7-5パッチ情報 

7.6 フリーエッジ 

パッチ情報では閉じていない辺を確認することができるが、ここではその辺を縫い合わ

せることができる。縫い合わせる辺が属する面を選択して、「マークする」ボタンを押し

てその場所を確認する。その後、「実行」ボタンを押すと、マークされた辺を三角形で縫

い合わせて、元の三角形パッチを修正する。 
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図 7-6ギャップがあるモデル 

 

図 7-7閉じていな辺をマークする 

 

図 7-8マークされた辺 
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図 7-9閉じられた辺 

7.7 ADVENTURE_TetMeshメッシュ生成パラメータの設定 

REVOCAP_PrePost では四面体メッシュ生成に ADVENTURE_TetMesh を呼び出し

ている。ここでは ADVENTURE_TetMesh のためのパラメータを設定する。基準長さは

メッシャーが節点を配置する場合の間隔の目安となる値で、生成される四面体の辺の長さ

と同程度になる。0 を指定した場合は、三角形パッチの辺の長さの平均値を使う。２次要

素のオプションを有効にした場合は、四面体２次要素を生成する。 

許容要素高最小値を指定すると、表面メッシュ生成プログラム TetMesh_P で節点間隔

と要素高の比がこの値よりも小さい要素を削除する。平滑化オプションでは、TetMesh_P 

で併用する平滑化の手法を指定する。 

面分割閾値は ADVENTURE_TetMesh のパラメータではないが、生成したメッシュの表

面を分割するときの角度の閾値を与える。 

詳細は ADVENTURE プロジェクトの ADVENTURE_TetMesh のマニュアルをご覧

ください。 
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図 7-10メッシュ生成パラメータ 

7.8 メッシュ生成粗密定義の方法 

ここでは、ADVENTURE_TetMesh でメッシュ生成を行う場合の節点密度制御パラメー

タの設定を行うことができる。密度パターンとして 

 点からの距離に反比例 

 線分からの距離に反比例 

 円筒からの距離に反比例 

に対応している。複数の密度パターンを併用することもできる。この機能を利用する場

合は、ADVENTURE_TetMesh の基準長さのパラメータを 0以外の値を与えなければなら
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ない。 

点からの距離に反比例の項目では、中心からの距離が大きくなるにつれて、節点密度が

低下していく。r で半径、(center_x, center_y, center_z) で中心の座標を与え、中心では基

準長さで与えられた節点密度の density 倍の密度で節点を配置する。表示ボタンにチェッ

クを入れると、与えられた球の範囲を半透明で図示する。 

線分からの距離に反比例の項目では、中心が点ではなく線分で与えられるため、(start_x, 

start_y, start_z) と (end_x, end_y, end_z) で線分の端点の値を与える。表示ボタンにチェ

ックを入れると、与えられた円柱の範囲を半透明で図示する。 

円筒からの距離に反比例の項目では、r4 < r3 < r2 < r1 で円筒の半径方向を与え、r3 か

ら r2 の範囲で節点密度を density 倍にする。r5 は円筒の軸方向の長さを指定する。表示

ボタンにチェックを入れると、与えられた円柱の範囲を半透明で図示する。 

 

図 7-11円筒からの距離に反比例（ADVENTURE_TetMesh マニュアルより） 

詳細は ADVENTURE プロジェクトの ADVENTURE_TetMesh のマニュアルをご覧

ください。 
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図 7-12点からの距離に反比例 
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図 7-13線分からの距離に反比例 
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図 7-14円筒からの距離に反比例 

7.9 押し出しメッシュ生成 

押し出しメッシュ生成機能は、既に生成されたメッシュに対して、特定の面を押し出し

たメッシュを追加する機能である。選択された面が三角形からなる場合は、押し出しメッ

シュは三角柱になる。TreeViewのMeshGenerationではなく、メッシュを生成した後の境

界条件設定などの画面で行われることに注意する。 

TreeViewから押し出しメッシュ生成の項目を選ぶ。 
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図 7-15押し出しメッシュ生成の設定 

 3DViewの画面の中で、押し出しメッシュを生成する面を選択する。 
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図 7-16押し出しメッシュ生成の対象の選択 

 層の数と一層の高さを設定して「GenerateExtrude」ボタンを押す。 

 

図 7-17押し出しメッシュ生成の結果 

 選択した面に押し出しメッシュが生成される。 

7.10 境界層メッシュ生成 

境界層メッシュ生成機能は、構造物の周りの外部流のメッシュを生成するときに、あら

かじめ構造物の周りに薄い境界層メッシュを作成してから、その外部の流体領域をメッシ

ュ生成する機能である。 

入力が形状ファイルであること、ADVENTURE_TetMesh_P が動作して表面メッシュが

作成できること、構造物の全体を囲むような流体領域をメッシュ生成することが条件であ

る。 

まず最初に構造物の形状ファイルを読み込む。その後、直接メッシュ生成をせずに外部

流体領域のメッシュ生成の設定画面を開く。 
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図 7-18境界層メッシュ生成の設定 

ここで、構造物を囲むように外部領域を定義する。また、構造物の周りに作成する境界

層の数と層の高さを指定する。3DViewの中に外部領域は半透明で表示されるので、それで

構造物を取り囲んでいるかどうかを確認する。 
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図 7-19外部流体領域の確認 

メッシュ生成ボタンを押すと、境界層つきの流体領域のメッシュが生成される。ただし、

複雑形状で、層の数が多い場合は生成した境界層の形状が干渉する等のため、流体領域の

メッシュ生成に失敗する場合があるので注意する。 

 

図 7-20生成した境界層メッシュ 

7.11 複数領域のメッシュ生成について 

複数の部品などからなる複数領域のメッシュ生成を行う場合、領域（部品）ごとに CAD 

ファイルを読み込まなければならない。 
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複数領域の三角形パッチは OpenCASCADE を用いて生成しているため、

ADVENTURE_TetMesh が想定している ADVENTURE_Tripatch の三角形パッチとは

若干性質が異なる部分があるために、失敗する場合がある。詳細は ADVENTURE プロジ

ェクトの ADVENTURE_Tripatch のマニュアルをご覧ください。
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8 REVOCAP_PrePost のポスト処理 

8.1 概要 

REVOCAP_PrePost のポスト処理機能では、計算結果ファイルを読み込んで、コンター

表示、変形表示、断面表示、等値面表示などを行う。これらはソルバに関わらず共通の操

作で実現されるのでここでまとめて説明する。 

8.2 計算結果ファイルの読み込み 

それぞれのソルバの計算結果を読み込む。対応している入力ファイルフォーマットにつ

いては、それぞれのソルバに関する項目を参照のこと。 

8.3 表面コンター図 

TreeViewの Contour項目を選択する。 

表面コンターの設定画面が現れる。 

 

図 8-1表面コンター図設定 
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 Item で表面コンターで表示する物理量を選択する 

 Comp で物理量が多次元の時には、成分を表示するのか、絶対値を表示するのか

を選択する。 

 Step でコンターの色の個数を選択する（0を与えた場合は、スムーズコンターに

なる） 

 Max と Min でコンター表示の最大最小値を与える。チェックボックスをつけず

に「設定」ボタンを押すと、物理量の最大最小値を自動的に計算してその値を用いる。 

 「カラーバー表示」で 3DView画面にカラーバーを表示するかどうかを選択する。 

 「コンター表示有効」にチェックをつけると３Ｄ画面内のモデルがコンター表示

される。 

表面コンター図の表示において、標準の設定では Drawing メニューの Rendering オプ

ションが有効になっている。これは光源の設定と光の反射を計算して立体感を出すように

している。この場合は光の反射具合によって表示上の色が変わるので、表面コンターの結

果評価画像をレポート等で利用する場合は、Rendering オプションを無効にすることを推

奨する。 

8.4 変形図 

Treeviewの Deform項目を選択すると、変形図の設定画面が現れる。 

 

図 8-2変形表示設定 
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 変形パラメータで変形表示を行う物理量をを与える（ここではベクトル値と認識

した物理量のみが表示される） 

 変形倍率を与える 

 「変形倍率」ボタンを押すと、変形量の最大値に応じて適切な変形倍率を設定す

る。 

 「Apply」ボタンを押すと、３Ｄ画面内のモデルが変形表示される。ボタンはトグ

ルで Apply と Cancel が切り替わる。 

計算結果ファイルにベクトル値として物理量が格納されていないと、変形表示の対象と

ならないので注意する。たとえば、u,v,w という３つのスカラー物理量で変形表示を行うこ

とはできない。ただし、FrontISTR、FrontFlow/blue の計算結果ファイルについては、ベ

クトル物理量の読み込みに対応済みである。 

8.5 断面図 

TreeView の Section 項目を選択すると、断面図の設定画面が現れる。 
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図 8-3断面図設定 

切断面の選択項目について 

 無効：通常のメッシュの表示 

 有効：切断面の片側のみを描画する（断面は描画しない） 

 断面表示：切断面の片側と断面を描画する。 

 断面要素表示：切断面の片側と断面を交差する要素を描画する（四面体のみ対応） 

表面コンターを設定済みで、切断面を断面表示に設定したときには、切断面についても

コンター表示が適用される。 

断面の設定や異動については、 

 球面極座標を与える方法 

 法線ベクトルと基準点を与える方法 

のいずれでも可能である。 
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8-4断面コンター表示の例 

断面スナップショットで「追加」ボタンを押すと、現在描画中の切断面をスナップショ

ットとして固定する。この機能を使うと 3D画面上に複数の断面を同時に表示することが可

能になる。 

8.6 ベクトル図 

TreeView の Vector 項目を選択すると、ベクトル図の設定画面が現れる。 
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図 8-5ベクトル図設定 

Item でベクトル表示を行う物理量を与える。 

倍率でベクトル表示を行う場合の 3D画面に表示する倍率を指定する。Item を選択する

と、自動的に最大値とモデルの大きさから適当な値が設定される。 

ベクトル表示の項目では、ベクトルを節点のすべてに対して描画するか、表面だけにつ

いて描画する課について選択できる。断面のみを選択すると、断面図を選択しているとき

に、その断面上だけベクトルを表示する。 

表示するベクトルの色はカラーバーの設定で行う。Step および Max Min の設定内容に

ついては、表面コンターの設定と同じである。 

8.7 等値面図 

TreeView の IsoSurface 項目を選択すると、等値面の設定画面が現れる。 



53 

 

 

図 8-6等値面設定 

Item で等値面表示する物理量を与える。 

Step Max Min は表面コンターの設定と同じである。 

Value に等値面を描画する物理量の値を与える。 

等値面表示を有効にすると、3D画面上で等値面を表示する。コンターバーのスライダー

を動かすと、Value の値が変化し、その値で等値面を再描画する。 

8.8 流線図 

TreeViewの StreamLine項目を選択すると、流線図の設定画面が表示される。ベクトル

値の計算結果について、それをベクトル場とみなしたときに、初期の点をいくつか置いて

それらの点がベクトル場に沿って流れていく時の軌跡を表示する。 
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8-7流線図設定 

流体解析において、流線を描画するときには流れの流入付近に初期点を置くとよい。こ

こでは初期点を１つ１つ座標で与えるのではなく、範囲と個数を与えると適当に初期点を

配置する。ラインの幅は流線の画面上のピクセル数である。刻み幅は軌跡を計算するとき

の時間刻みで、ステップ数はその刻み幅で何回軌跡をたどるかを表す。  

バケット作成のチェックボタンをオンにすると、要素を検索するためにバケットを作成

してから流線を描画するので高速に描画できる。ただしバケットの作成にもメモリを消費

するので大規模モデルの場合はメモリ不足で正常に動作しない場合もある。 
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8-8流線の表示例 

8.9 アニメーション生成 

TreeView の Animation 項目を選択すると、アニメーションの設定画面が表示される。

アニメーションの生成では、時系列やステップごとに出力された複数の計算結果ファイル

が必要である。 
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図 8-9アニメーション生成画面 

アニメーションを生成する最初のファイルを読み込んで、あらかじめ適当なポスト処理

（表面コンター、変形など）を行っておく。このポスト処理について、時系列やステップ

ごとの変化をみることができる。ファイル追加ボタンを押して、同じモデルの複数の計算

結果ファイルを指定してリストに追加する。実行ボタンを押すと、リストにあるファイル

を順に読んで、オフスクリーンでレンダリングを行い画像ファイルを出力する。 

8.10 注意 

ポスト処理の設定を行ったときには、通常すぐに 3DViewの画面を再描画しているが、

ビデオカードとの相性によっては、OSのイベントを与えなければ再描画を行わない場合が

ある。その場合は、視点を変更したり、3DView内をクリックしたりすると、画面が更新さ

れる。 
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9 FrontISTR 用マニュアル 

9.1 対応するソルバ 

「次世代ものづくりシミュレーションソフトウェアの作成プロジェクト」にて開発され

た FrontISTR Ver. 3.3に対応する。そのバージョン以降の機能については未対応であるの

で注意する。ただし FrontISTR Ver.4.1の機能については一部対応している。 

9.2 プレ・ポスト処理の手順 

REVOCAP_PrePostによる FrontISTRのプレ処理の手順は以下のとおりである。 

(1) 形状ファイルの読み込み・メッシュ生成（またはメッシュファイルを読み込み） 

(2) 解析の種類の選択 

(3) 材料物性値の設定 

(4) 境界条件の設定 

(5) 解析条件の設定 

(6) 解析モデルファイル出力 

である。解析モデルを出力後、FrontISTR による解析を実行することができる。以下で

はこの手順に従って説明をする。 

REVOCAP_PrePost による FrontISTRのポスト処理の手順は、以下のとおり 

計算結果ファイルの読み込み 

ポスト表示の種類（コンター、変形など）と、ポスト表示の対象となる物理量を選択 

ポスト処理の実行 

である。 

9.3 入出力仕様 

プレ入力 

形状ファイル 

 IGES 

 STEP 

 STL 
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 ADVENTURE _Tripatchフォーマットのパッチデータ 

メッシュファイル 

 HECMW形式のメッシュファイル 

 ADVENTURE _TetMesh形式のメッシュファイル 

 MicroAVS UCD形式のメッシュファイル 

プレ出力 

解析モデルファイル 

 HECMW形式のメッシュファイル 

 FrontISTR解析制御ファイル 

 FrontISTR全体制御ファイル 

ポスト入力 

計算結果ファイル 

 HECMW形式 RESファイル 

 HECMW形式のメッシュファイル 

 MicroAVS UCD形式の計算結果ファイル 

ポスト出力 

画像データ 

 JPEG, PNG, BMP 形式の画像データ 

9.4 形状ファイルの読み込み・メッシュ生成 

FEM解析のためのメッシュがない場合、CADデータなどの形状データからメッシュを

生成する。既にメッシュファイルがある場合は、このプロセスは省略してよい。詳細はメ

ッシュ生成の章を参照のこと。 

9.5 メッシュファイルの読み込み 

メッシュ生成に成功した場合は生成したファイルを自動で読み込む。既存の解析用のメ

ッシュがある場合は、メッシュファイルを読み込んでそこに解析条件を設定して解析モデ

ルを作成することができる。 

メニューから File => Open Meshを選び、入力するメッシュファイルを与える、 

固体領域に名前が与えられているようなメッシュファイル（HECMW 形式など）を読み

込んだ場合は、TreeViewのModelの項目の下にその名前で固体領域を表示する。固体領域
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に名前が与えられていない場合は、modelname_1、modelname_2 のような名前

（modelnameはファイル名）で表示する。 

固体領域の境界面はメッシュファイルを読み込むときに自動的に抽出する。抽出した境

界面は Treeviewにおいてその親の固体領域の下の項目に Face01、Face02のような名前で

表示する。 

 

図 9-1 メッシュファイルを読み込んだ後の TreeView 

TreeViewにおいて固体領域を選択すると、LogMessagePane画面にその固体領域の情報

が表示される。 



60 

 

9.6 解析の種類の選択・解析の設定 

本バージョンで対応しているのは、 

 線形弾性静解析(STATIC) 

 非線形静解析(NLSTATIC) 

 固有値解析(EIGEN) 

 熱伝導解析(HEAT) 

 動解析(DYNAMIC) 

の 5種類である。 

解析条件の設定 

解析の種類の選択は TreeViewから「解析の種類」の項目を選択して、CustomPaneに表

示された「解析の種類の選択」で行う。 

 

図 9-2 解析条件の設定 

同時にソルバのバージョンの設定も行う。ソルバのバージョンによって出力されるメッ

シュファイルおよび解析制御ファイルのフォーマットが異なるので注意する。 

解析の種類を選択したら、TreeViewの「解析の種類」の下の項目でそれぞれの解析の種

類に関する設定を行うことができる。（線形弾性・非線形）静解析についての設定項目はな
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い。ただし非線形静解析を設定した場合は、この設定以外にステップ解析についての設定

が必要である。解析の種類に応じた設定内容の詳細は FrontISTRのマニュアルを参照して

いただきたい。 

固有値解析の条件設定 

Treeview の「解析の種類」の下の「固有値解析」の項目を選択すると固有値解析の設定

画面が CusomPaneに表示される。 

 

図 9-3 固有値解析の条件設定 

熱伝導解析の条件設定 

TreeViewの「解析の種類」の下の「熱伝導解析」の項目を選択すると熱伝導解析の設定

画面が CusomPaneに表示される。 

 

図 9-4 熱伝導解析の条件設定 
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動解析の条件設定 

TreeView の「解析の種類」の下の「動解析」の項目を選択すると動解析の設定画面が

CusomPaneに表示される。 
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図 9-5 動解析の条件設定 

9.7 材料物性値の設定 

REVOCAP_PrePost において固体領域に材料物性値を設定するには、最初に材料物性デ

ータベースにヤング率、ポアソン比などの材料物性パラメータの組に名前をつけて登録し、

その名前を固体領域に割り当てるという手順を取る。材料物性値データベースには主要な

物質の値があらかじめ登録されている。 

材料物性データベースの設定 

材料物性データベースにパラメータを登録するには、TreeViewで「材料物性値」の項目

を選択し、CustomPaneに材料物性データベースの設定画面を表示させる。材料物性値の

選択メニューから選択すると、既に登録済みの値を確認することができる。新たに材料物

性値を登録する場合は、材料物性値のモデルと降伏条件、硬化則を選択して、ヤング率、

ポアソン比、密度、線膨脹係数、熱伝導率、比熱などの物性値パラメータに値を入力する。 

材料物性値のモデルに応じて、設定すべきパラメータが変化する。解析で利用するモデ

ル以外のパラメータについては入力しなくてもよい。温度依存性を持つ物性値パラメータ

の場合は、あらかじめ温度依存性を csvファイルに記述しておいて、物性値パラメータはそ
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の csvファイル名を与える。 

 

図 9-6 材料物性データベースの設定 

固体領域に設定した物性値を与えるには、データベースに登録する必要がある。新規に

入力した場合または既存の物性値を修正した場合は、新たに登録名を指定して「追加」ボ

タンを押す。ここで与える登録名はそのまま FrontISTRのMaterial の識別子で使われる

ので、半角英数字で与えなければならない。 

材料物性値のデータベースは、以下のような CSVファイルで保存することができる。 

material,young,poisson,density,linearexp,thermal_conductivity,specific_heat 
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unit,Pa,,kb m^-3,K^-1,W m^-2 K^-1,J kg^-1 K^-1 

Aluminum,70000000000,0.345,2690,2.50E-05,237,1.00E-06 

REVOCAP_PrePostアプリケーションの FSTRフォルダにあるmat.csvというファイル

が起動時に初期値で読み込まれる材料物性値のデータベースである。このファイルを変更

すると、デフォルトのデータベースが置きかえられる。 

材料物性値の固体領域への割り当て 

材料物性値データベースに登録されている材料物性値を固体領域に割り当てなければな

らない。TreeView の計算格子の項目の下の固体領域の項目を選択する。このとき

CustomPane には材料物性設定用の画面が表示されるので、そこで登録されている材料物

性値の名前と材料モデルを選択して登録する。 

 

図 9-7 材料物性値の固体領域への割り当て 

9.8 境界条件の設定 

下に挙げる境界条件については、解析の種類によって設定できる項目が異なる。初めに

解析の種類を選択してからでないと、目的の境界条件が設定できないので注意する。 

以下の境界条件の設定で与える名前は FrontISTRの識別子としても使われるため、すべ
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て半角英数で与えなければならない。 

節点拘束・変位(BOUNDARY) 

静解析、固有値解析、動解析のときに設定可能である。FrontISTR でのパラメータ名は

BOUNDARY である。TreeView の境界条件の項目の下の BOUNDARY を選択する。境界

条件の識別子を Name に与える。設定画面が表示されている状態で、面全体を選択、また

は Lasso ボタンを有効にしてマウスで範囲を選択する。設定できるのは拘束または変位の

方向と値である。拘束条件の場合は、拘束する方向にチェックを入れて、数値は 0.0を与え

る。強制変位の場合は、変位を与える方向にチェックを入れて、変位の値を与える。 

「追加」ボタンを押すと境界条件が追加され、TreeView の BOUNDARY の項目の下に

境界条件名の項目が追加される。 

 

図 9-8 節点拘束・変位(BOUNDARY) 

既に与えられている境界条件を編集する場合は TreeView の BOUNDARY の項目の下の

それぞれの節点拘束・変位の境界条件を選択し、数値を修正して「更新」ボタンを押す。
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境界条件を削除する場合は、TreeViewの BOUNDARYの項目の下のそれぞれの節点拘束・

変位の境界条件を選択し、「削除」ボタンを押す。 

集中荷重(CLOAD) 

静解析、動解析のときに設定可能である。FrontISTRでのパラメータ名は CLOADであ

る。TreeView の境界条件の項目の下の CLOAD を選択する。境界条件の識別子を Name

に与える。設定画面が表示されている状態で、面全体を選択、または Lasso ボタンを有効

にしてマウスで範囲を選択する。設定できるのは荷重ベクトルの x、y、z の方向の 3 成分

である。ここでは選択された節点全てに同一の荷重を与えることになるので注意する。必

要に応じて「節点数の確認」ボタンで選択されている節点の個数を確かめて、荷重値を調

整する。 

 

図 9-9 集中荷重(CLOAD) 

「追加」ボタンを押すと境界条件が追加され、TreeViewの CLOADの項目の下に境界条

件名の項目が追加される。 

既に与えられている境界条件を編集する場合はTreeViewのCLOADの項目の下のそれぞ

れの集中荷重の境界条件を選択し、数値を修正して「更新」ボタンを押す。境界条件を削

除する場合は、TreeViewのCLOADの項目の下のそれぞれの集中荷重の境界条件を選択し、

「削除」ボタンを押す。 

面荷重(DLOAD) 

静解析、動解析のときに設定可能である。FrontISTRでのパラメータ名は DLOADであ
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る。TreeView の境界条件の項目の下の DLOAD を選択する。境界条件の識別子を Name

に与える。設定画面が表示されている状態で、面全体を選択、または Lasso ボタンを有効

にしてマウスで範囲を選択する。設定できるのは圧力値である。 

 

図 9-10 面荷重(DLOAD) 

「追加」ボタンを押すと境界条件が追加され、TreeViewの DLOADの項目の下に境界条

件名の項目が追加される。 

既に与えられている境界条件を編集する場合は TreeView の DLOAD の項目の下のそれ

ぞれの面荷重の境界条件を選択し、数値を修正して「更新」ボタンを押す。境界条件を削

除する場合は、TreeView の DLOAD の項目の下のそれぞれの面荷重の境界条件を選択し、

「削除」ボタンを押す。 

体積力(DLOAD) 

静解析のときに設定可能である。TreeViewの境界条件の項目の下のVLOADを選択する。

FrontISTRの解析制御ファイルでは DLOADの BX BY BZで与えられるが、面荷重と区別

するために REVOCAP_PrePostでは VLOADと表示していることに注意する。境界条件の

識別子をNameに与える。設定できるのは方向と値である。 

 

図 9-11 体積力(DLOAD) 

「追加」ボタンを押すと境界条件が追加され、TreeViewの VLOADの項目の下に境界条

件名の項目が追加される。3DViewの中では特にアイコン表示等はされない。 
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既に与えられている境界条件を編集する場合はTreeViewのVLOADの項目の下のそれぞ

れの体積力の境界条件を選択し、数値を修正して「更新」ボタンを押す。境界条件を削除

する場合は、TreeViewの VLOADの項目の下のそれぞれの体積力の境界条件を選択し、「削

除」ボタンを押す。 

重力(DLOAD) 

静解析のときに設定可能である。TreeView の境界条件の項目の下の GRAV を選択する。

FrontISTRの解析制御ファイルでは DLOAD GRAV に分類されるが、面荷重と区別するた

めに REVOCAP_PrePost では GRAV と表示していることに注意する。境界条件の識別子

を Nameに与える。設定できるのは x、y、z方向の 3成分の値である。FrontISTRの内部

では絶対値と単位ベクトルに分解して記述されるが、REVOCAP_PrePostからは 3方向の

ベクトルとして与える。 

 

図 9-12 重力(DLOAD) 

GRAV のチェックボタンをオンにすると、重力の境界条件が有効になる。数値を修正し

て更新ボタンを押すと、値が更新される。 

遠心力(DLOAD) 

静解析のときに設定可能である。TreeViewの境界条件の項目の下の CENTを選択する。

FrontISTRの解析制御ファイルでは DLOAD CENT に分類されるが、面荷重と区別するた

めに REVOCAP_PrePost では CENT と表示していることに注意する。境界条件の識別子

を Name に与える。設定できるのは角速度、位置ベクトル、方向ベクトルの 7 成分の値で

ある。 
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図 9-13 遠心力(DLOAD) 

「追加」ボタンを押すと境界条件が追加され、TreeView の CENT の項目の下に境界条

件名の項目が追加される。3DViewの中では特にアイコン表示等はされない。 

既に与えられている境界条件を編集する場合は TreeView の CENT の項目の下のそれぞ

れの遠心力の境界条件を選択し、数値を修正して「更新」ボタンを押す。境界条件を削除

する場合は、TreeViewの CENTの項目の下のそれぞれの遠心力の境界条件を選択し、「削

除」ボタンを押す。 

参照温度(REFTEMP) 

静解析で熱応力解析を行う場合に設定する。FrontISTRでのパラメータは REFTEMPで

ある。TreeVewの境界条件の項目の下の REFTEMPを選択し、参照温度を与える。空欄に

した場合は参照温度を与えない。 

 

図 9-14 参照温度 (REFTEMP) 

節点温度(TEMPERATURE) 

静解析で熱応力解析を行う場合に設定する。FrontISTR でのパラメータ名は

TEMPERATURE である。TreeView の境界条件の項目の下の TEMPERATURE を選択す
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る。境界条件の識別子を Name に与える。設定画面が表示されている状態で、面全体を選

択、または Lasso ボタンを有効にしてマウスで範囲を選択する。設定できるのは温度の値

である。 

 

図 9-15 節点温度(TEMPERATURE) 

「追加」ボタンを押すと境界条件が追加され、TreeView の TEMPERATURE の項目の

下に境界条件名の項目が追加される。 

既に与えられている境界条件を編集する場合は TreeView の TEMPERATURE の項目の

下のそれぞれの節点温度の境界条件を選択し、数値を修正して「更新」ボタンを押す。境

界条件を削除する場合は、TreeView の TEMPERATURE の項目の下のそれぞれの節点温

度の境界条件を選択し、「削除」ボタンを押す。 

接触ペア(CONTACTPAIR) 

非線形静解析の時に接触面のペアを設定する。FrontISTR でのパラメータ名は

CONTACTPAIRである。TreeVewの境界条件の項目の下の CONTACTPAIR を選択すると

設定用の画面が表示される。接触面ペアの識別子を PAIR_NAME に与える。 

ここでは接触面として、モデルの表示に使われている面の名前を与える。面を選択して

いる状態で「MASTER_GRP」ボタンを押すと、その面の名前が与えられる。同様にして

「SLAVE_GRP」にも面の名前を与える。 

 

図 9-16 接触ペア (CONTACTPAIR) 
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「追加」ボタンを押すと接触面ペアが追加され、TreeViewの CONTACTPAIRの項目の

下に接触面ペアの識別子名の項目が追加される。 

既に与えられている接触面ペアを編集する場合はTreeViewのCONTACTPAIRの項目の

下のそれぞれの接触面ペアの境界条件を選択し、面の名前を修正して「更新」ボタンを押

す。接触面ペアを削除する場合は、TreeViewの CONTACTPAIR の項目の下の接触面ペア

の識別子を選択し、「削除」ボタンを押す。 

接触(CONTACT) 

接触条件を設定する。非線形静解析の時に設定可能である。FrontISTR でのパラメータ

名は CONTACT である。TreeVew の境界条件の項目の下の CONTACT を選択すると設定

用の画面が表示される。接触条件の識別子を Nameに与える。 

パラメータ INTERACTION、NTOL、TTOL、NPENALTY、TPENALTY を与え、

CONTACTPAIRで定義した接触面ペアに対して fcoef、factorの値を設定して「表に追加」

する。 

CONTACT条件の「追加」ボタンを押すと接触条件が追加され、TreeViewの CONTACT

の項目の下に接触条件の識別子名の項目が追加される。 

すでに与えられている接触条件を編集する場合は TreeView の CONTACT の項目の下に

ある接触条件を選択して、パラメータ等を修正して「更新」ボタンを押す。 

接触条件を削除する場合は、TreeView の CONTACT の項目の下の接触条件の識別子を

選択し、「削除」ボタンを押す。 
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図 9-17 接触(CONTACT) 

全節点拘束(DIM) 

静解析、固有値解析、動解析のときに設定可能である。全ての節点に対して、ある特定

の報告の拘束を与える場合に用いる。FrontISTRの解析制御ファイルでは BOUNDARYで

あるが、特殊な用途について簡単に設定するために REVOCAP_PrePost では DIM として

表示している。TreeView の境界条件の項目の下の DIM を選択する。全ての節点に与える

ため識別子はない。設定できるのは拘束する方向である。 
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図 9-18 全節点拘束 (DIM) 

チェックボックスをオンにすると、その方向の拘束が与えられる。編集する場合は、

TreeViewの境界条件の DIMを選択して、条件を編集して「更新」ボタンを押す。 

アセンブリ対(ASSEMBLY_PAIR) 

アセンブリ対を設定する。この条件は FrontISTR Ver.4.1で有効であるが、便宜上 Ver.3.3

でも利用できるようになっている。 

アセンブリ対の識別子を PAIR_NAME に与え、3DView で面を選択した状態で

「MASTER_GRP」ボタンを押すと、マスター面の名前に選択した面の名前が与えられる。

同様に「SLAVE_GRP」ボタンを押すと、スレイブ面の名前に選択した面の名前が与えら

れる。 

 

図 9-19 アセンブリ対(ASSEMBLYPAIR) 

特定の方向だけアセンブリ条件を与える場合は、その方向以外の x、y、z のチェックボ
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ックスをオフにする。「追加」ボタンを押すとアセンブリ対が追加され、TreeView の

ASSEMBLYPAIR の項目の下にアセンブリ対の識別子の項目が追加される。 

既に与えられているアセンブリ対を編集する場合は TreeView の ASSEMBLYPAIR の項

目の下のそれぞれのマスター面の名前、スレイブ面の名前を編集して「更新」ボタンを押

す。 

アセンブリ対を削除する場合は、TreeView の ASSEMBLYPAIR の項目の下のアセンブ

リ対の識別子を選択し、「削除」ボタンを押す。 

速度境界条件(VELOCITY) 

動解析で設定可能である。FrontISTRでのパラメータ名は VELOCITYである。TreeView

の境界条件の項目の下の VELOCITY を選択する。境界条件の識別子を Name に与える。

設定画面が表示されている状態で、面全体を選択、または Lasso ボタンを有効にしてマウ

スで範囲を選択する。設定できるのは速度の x、y、z成分の値である。 

 

図 9-20 速度境界条件 (VELOCITY) 

「追加」ボタンを押すと境界条件が追加され、TreeViewの VELOCITY の項目の下に境

界条件名の項目が追加される。 

既に与えられている境界条件を編集する場合はTreeViewのVELOCITYの項目の下の速

度境界条件を選択し、数値を修正して「更新」ボタンを押す。境界条件を削除する場合は、

TreeViewの VELOCITYの項目の下のそれぞれの節点温度の境界条件を選択し、「削除」ボ

タンを押す。 
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加速度境界条件(ACCELERATION) 

動解析で設定可能である。FrontISTR でのパラメータ名は ACCELERATION である。

TreeView の境界条件の項目の下の ACCELERATION を選択する。境界条件の識別子を

Name に与える。設定画面が表示されている状態で、面全体を選択、または Lasso ボタン

を有効にしてマウスで範囲を選択する。設定できるのは加速度の x、y、z成分の値である。 

 

図 9-21 加速度境界条件 (ACCELERATION) 

「追加」ボタンを押すと境界条件が追加され、TreeView の ACCELERATION の項目の

下に境界条件名の項目が追加される。 

既に与えられている境界条件を編集する場合はTreeViewのACCELERATIONの項目の

下の加速度境界条件を選択し、数値を修正して「更新」ボタンを押す。境界条件を削除す

る場合は、TreeView の ACCELERATION の項目の下のそれぞれの加速度境界条件を選択

し、「削除」ボタンを押す。 

規定温度(FIXTEMP) 

熱伝導解析のときに設定可能である。FrontISTRでのパラメータ名は FIXTEMPである。

TreeView の境界条件の項目の下の FIXTEMP を選択する。境界条件の識別子を Name に

与える。設定画面が表示されている状態で、面全体を選択、または Lasso ボタンを有効に

してマウスで範囲を選択する。設定できるのは温度の値である。 
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図 9-22 規定温度(FIXTEMP) 

「追加」ボタンを押すと境界条件が追加され、TreeViewの FIXTEMPの項目の下に境界

条件名の項目が追加される。 

既に与えられている境界条件を編集する場合は TreeView の FIXTEMP の項目の下のそ

れぞれの規定温度の境界条件を選択し、数値を修正して「更新」ボタンを押す。境界条件

を削除する場合は、TreeViewの FIXTEMPの項目の下のそれぞれの規定温度の境界条件を

選択し、「削除」ボタンを押す。 

集中熱流束(CFLUX) 

熱伝導解析のときに設定可能である。FrontISTR でのパラメータ名は CFLUX である。

TreeViewの境界条件の項目の下の CFLUXを選択する。境界条件の識別子を Nameに与え

る。設定画面が表示されている状態で、面全体を選択、または Lasso ボタンを有効にして

マウスで範囲を選択する。設定できるのは熱流束値の値である。 

 

図 9-23 集中熱流束(CFLUX) 

「追加」ボタンを押すと境界条件が追加され、TreeViewの CFLUXの項目の下に境界条

件名の項目が追加される。 

既に与えられている境界条件を編集する場合はTreeViewのCFLUXの項目の下のそれぞ
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れの集中熱流束の境界条件を選択し、数値を修正して「更新」ボタンを押す。境界条件を

削除する場合は、TreeViewの CFLUXの項目の下のそれぞれの集中熱流束の境界条件を選

択し、「削除」ボタンを押す。 

（面に与える）分布熱流束(DFLUX) 

熱伝導解析のときに設定可能である。FrontISTR でのパラメータ名は DFLUX である。

TreeViewの境界条件の項目の下の DFLUXを選択する。境界条件の識別子を Nameに与え

る。設定画面が表示されている状態で、面全体を選択、または Lasso ボタンを有効にして

マウスで範囲を選択する。設定できるのは熱流束値の値である。 

 

図 9-24 面熱流束(DFLUX) 

「追加」ボタンを押すと境界条件が追加され、TreeViewの DFLUXの項目の下に境界条

件名の項目が追加される。 

既に与えられている境界条件を編集する場合はTreeViewのDFLUXの項目の下のそれぞ

れの面熱流束の境界条件を選択し、数値を修正して「更新」ボタンを押す。境界条件を削

除する場合は、TreeViewのDFLUXの項目の下のそれぞれの面熱流束の境界条件を選択し、

「削除」ボタンを押す。 

内部発熱(IHEAT) 

熱伝導解析のときに設定可能である。FrontISTR でのパラメータ名は DFLUX である。

面に与える分布熱流束と区別するために REVOCAP_PrePost では別項目として設定する。

TreeViewの境界条件の項目の下の IHEATを選択する。境界条件の識別子を Nameに与え

る。熱流束値の値を設定する。対象となる要素は要素番号または領域の座標値で与えるこ

とができる。設定できるのは熱流束値の値である。 
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図 9-25 内部発熱 (IHEAT) 

「追加」ボタンを押すと境界条件が追加され、TreeView の IHEAT の項目の下に境界条

件名の項目が追加される。 

既に与えられている境界条件を編集する場合は TreeViewの IHEATの項目の下のそれぞ

れの内部発熱の境界条件を選択し、数値を修正して「更新」ボタンを押す。境界条件を削

除する場合は、TreeViewのDFLUXの項目の下のそれぞれの内部発熱の境界条件を選択し、

「削除」ボタンを押す。 

熱伝達係数(FILM) 

熱伝導解析の時に設定可能である。FrontISTR でのパラメータ名は FILM である。
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TreeView の境界条件の項目の下の FILM を選択する。境界条件の識別子を Name に与え

る。設定画面が表示されている状態で、面全体を選択、または Lasso ボタンを有効にして

マウスで範囲を選択する。設定できるのは熱伝達係数と雰囲気温度の値である。 

 

図 9-26 熱伝達係数(FILM) 

「追加」ボタンを押すと境界条件が追加され、TreeViewの FILMの項目の下に境界条件

名の項目が追加される。 

既に与えられている境界条件を編集する場合は TreeView の FILM の項目の下のそれぞ

れの熱伝達係数の境界条件を選択し、数値を修正して「更新」ボタンを押す。境界条件を

削除する場合は、TreeViewの FILMの項目の下のそれぞれの熱伝達係数の境界条件を選択

し、「削除」ボタンを押す。 

輻射係数(RADIATE) 

熱伝導解析の時に設定可能である。FrontISTRでのパラメータ名は RADIATE である。

TreeView の境界条件の項目の下の RADIATE を選択する。境界条件の識別子を Name に

与える。設定画面が表示されている状態で、面全体を選択、または Lasso ボタンを有効に

してマウスで範囲を選択する。設定できるのは輻射係数と雰囲気温度の値である。 
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図 9-27 輻射係数(RADIATE) 

「追加」ボタンを押すと境界条件が追加され、TreeViewの RADIATEの項目の下に境界

条件名の項目が追加される。 

既に与えられている境界条件を編集する場合は TreeView の RADIATE の項目の下のそ

れぞれの輻射係数の境界条件を選択し、数値を修正して「更新」ボタンを押す。境界条件

を削除する場合は、TreeViewの RADIATEの項目の下のそれぞれの輻射係数の境界条件を

選択し、「削除」ボタンを押す。 

温度初期条件(INITIAL) 

静解析で熱応力解析を行う場合、および熱伝導解析の時に設定可能である。FrontISTR

でのパラメータ名は INITIAL CONDITION (TYPE=TEMPERATURE)である。TreeView

の境界条件の項目の下の INITIALを選択する。初期条件の識別子をNameに与える。設定

画面が表示されている状態で、面全体を選択、または Lasso ボタンを有効にしてマウスで

範囲を選択する。設定できるのは初期条件の温度の値である。 

 

図 9-28 温度初期条件 (INITIAL) 
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「追加」ボタンを押すと温度初期条件が追加され、TreeView の INITIAL の項目の下に

温度初期条件名の項目が追加される。 

既に与えられている温度初期条件を編集する場合は TreeView の INITIAL の項目の下の

それぞれの温度初期条件を選択し、数値を修正して「更新」ボタンを押す。温度初期条件

を削除する場合は、TreeViewの INITIALの項目の下のそれぞれの温度初期条件を選択し、

「削除」ボタンを押す。 

絶対零度(ZERO) 

TreeViewの境界条件の項目の下の ZEROを選択する。解析モデルの絶対零度の値を与え

る。 

 

図 9-29 絶対零度(ZERO) 

境界条件のマーカーについて 

それぞれの境界条件のマーカーは面を選択して境界条件を与えた場合には、その面と連

動して動くが、Lasso 機能で範囲選択した場合には、面と連動して動かない場合がある

（Lassoで範囲指定した場合に複数の面にわたって節点や面を選択することがあるため、ど

の面と連動して動くのかが決まらない）。 

9.9 時間依存の境界条件 

時間依存の境界条件を与えるときの係数テーブルの設定をする。TreeViewの「時間変化」

の項目を選択する。時刻と値の組を任意個数設定し、名前をつけて「追加」ボタンを押す

と AMPLITUDE 項目の下に時間変化係数テーブルが追加される。 

既に与えられている時間変化係数テーブルを編集する場合は TreeViewの AMPLITUDE

の項目の下のそれぞれの時間変化係数テーブルを選択し、数値を修正して「更新」ボタン

を押す。時間変化係数テーブルを削除する場合は、TreeViewの AMPLITUDE の項目の下

の時間変化係数テーブルの名前を選択し、「削除」ボタンを押す。 
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図 9-30 AMPLITUDE 

AMPLITUDE で設定した時間変化係数テーブルを設定できるのは動解析の時には以下

の境界条件 

 BOUNDARY 

 CLOAD 

 DLOAD 

 VLOAD 

動解析の時には以下の境界条件 

 FIXTEMP 

 CFLUX 

 DFLUX 

 FILM(熱伝達係数と雰囲気温度それぞれで設定可能) 

 RADIATE(熱伝達係数と雰囲気温度それぞれで設定可能) 

である。 

それぞれの境界条件の設定画面でどの時間変化係数テーブルを用いるかの設定を行うこ

とが可能である。 
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9.10 ステップ解析の設定 

非線形解析（静解析および動解析の陰解法）を行う場合に、境界条件をステップ制御す

る必要がある。ここではその設定を行う。 

 

9-31ステップ解析の設定 
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分割ステップ数、収束判定値、最大反復回数、時間増分値、終了時間を設定する。この

ステップ制御で有効となる境界条件を選択して追加ボタンを押すと、TreeViewのステップ

解析の下に識別子の項目が追加される。 

既に与えられているステップ制御を編集する場合は TreeView のステップ解析の項目の

下のそれぞれのステップ制御の項目を選択し、修正して「更新」ボタンを押す。ステップ

制御を削除する場合は、TreeViewのステップ解析の項目を選択し、「削除」ボタンを押す。 

9.11 解析条件の設定 

TreeViewのソルバの項目を選択すると、解析条件の全体設定を行うことができる。ここ

では、出力されるファイルのファイル名、出力する場所、クラスタに転送する場合はその

場所などを設定できる。 

TreeView のソルバを選択する。FrontISTR の出力モデル名の設定では、FrontISTR 解

析モデルファイル（メッシュおよび解析制御ファイル）を出力する場合の拡張子の前の部

分の名前を指定する。また、出力ディレクトリ名を指定することができる。 

 

図 9-32 解析条件の設定 

 (注)ADVENTURE の TetMesh 形式と HECMW のメッシュファイルはどちらも拡張子

がmshであるためADVENTURE TetMeshで生成したメッシュファイルをモデル名に指定

して、出力ディレクトリを同じにすると上書きしてしまうので注意する。 

解析設定(Analysis) 

TreeViewのソルバの項目の下の「解析設定」を選択する。FrontISTR の解析パラメータ

の設定を行うことができる。パラメータについての詳細は FrontISTRのマニュアルを参照

していただきたい。 
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図 9-33 解析設定(Analysis) 

出力 (Output) 

TreeView のソルバの項目の下の「出力」を選択する。この項目では FrontISTR の解析

制御ファイルにおける出力制御に関する項目の設定を行う。REVOCAP_PrePost の実際の

ファイルの出力方法については、解析モデルファイル出力を参照のこと。 
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図 9-34 出力設定(Output) 

並列設定(Parallel) 

TreeView の並列の項目の下の「並列」を選択する。ここでは HECMW の並列計算機能

についての設定を行う。REVOCAP_Refiner が組み込まれている場合は、モデル細分機能

についての設定を行うことができる。 



88 

 

 

図 9-35並列設定 

可視化 (Visual) 

TreeView のソルバの項目の下の［可視化］Visual を選択する。HECMW の可視化機能

についての設定を行うことができる。パラメータについての詳細はHECMW-Visualのマニ

ュアルを参照していただきたい。 

 

図 9-36 画像出力設定(Visual) 
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9.12 解析モデルファイル出力 

Menuから File => Save Modelを選択すると解析モデルを出力することができる。 

9.13 解析実行 

FrontISTR のプログラム説明書などを参考にして解析を実行する。Windows 版の

FrontISTRを使う場合は、REVOCAP_PrePost から呼び出すこともできる。TreeView の

ソルバの項目の下の 「実行」を選択する。モデルの保存をしていない場合は、まずモデル

保存ボタンを押す。つぎに FrontISTR実行ボタンを押すと、解析を実行できる。 

 

図 9-37ソルバ実行設定 

9.14 計算結果ファイルの読み込み 

メニューからFile => Open Resultで計算結果ファイルを読み込む。WRITE RESULT オ

プションを  YES にしたときに出力される  HECMW RES 形式を読み込む場合は、

HECMW Mesh 形式も同時に読み込む必要がある。WRITE VISUAL オプションを YES 

にして、OUTPUT_TYPE を COMPLETE_AVS とした時に出力される MicroAVS UCD

形式の計算結果ファイルは 1つのファイルを読み込むだけでよい。 

並列の計算結果を読み込む場合は、HECMW RES 形式のみ対応している。この場合は、

Result ファイルを読み込むときに、複数の res ファイルを同時に選択する。 

9.15 読み込まれたデータの確認 

TreeViewの Data項目を選択する。その下の階層に、REVOCAP_PrePostに読み込まれ

たメッシュに付随するデータが列挙されている。データ名を選択すると、LogMessageにデ

ータ名の種類と対応している物理量の型が表示される。 
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9.16 ポスト処理 

FrontISTR のポスト処理では、表面コンター図、変形図、断面図、時系列画像作成に対

応している。それぞれの機能については、ポスト処理の項目を参照のこと。 

9.17 FrontISTR可視化機能の呼出し 

TreeViewの Visual 項目を選択する。 

HECMWの可視化機能のためのパラメータの設定を行う。 

 生成する BMPファイルの大きさを与える 

 画面内に表示されるフォントの大きさを与える 

 可視化画面を生成するときの視点を与える 

 描画する表面の種類を選択する 

9.18 設定情報 

FrontISTR に関する固有の設定は REVOCAP_PrePost をインストールしたディレクト

リの FSTRという名前のサブディレクトリに保存している。 

 i386-mswin32 : Windows 環境での実行ファイル格納用ディレクトリ 

 x64_mswin64_100：Windows 64bit環境での実行ファイル格納用ディレクトリ 

 PropDB.ini : REVOCAP_PrePost用の初期設定ファイル 

 fistr_cx1000.template：東大生研スパコン CX1000で実行する場合のジョブスク

リプト生成テンプレート 

 Remote_Fistr_CX1000.ini：東大生研スパコン CX1000用リモート環境初期設定

ファイル 

初期設定ファイルは yaml 形式で記述する。 
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10 FrontFlow/blue 用マニュアル 

10.1 対応するソルバ 

文部科学省次世代ＩＴ基盤構築のための研究開発「革新的シミュレーションソフトウェ

アの研究開発」にて開発された FrontFlow/blue Ver. 7.1に対応する。 

10.2 プレ・ポスト処理の手順 

REVOCAP_PrePostによる FrontFlow/blueのプレ処理の手順は、以下のとおり。 

形状ファイルの読み込み・メッシュ生成（またはメッシュファイルを読み込み） 

境界条件の設定 

解析条件の設定 

解析モデルファイル出力 

である。解析モデルを出力後、FrontFlow/blue による解析を実行することができる。以

下ではこの手順に従って説明をする。 

REVOCAP_PrePostによる FrontFlow/blueのポスト処理の手順は、以下のとおり。 

メッシュファイルの読み込み 

計算結果ファイルの読み込み（ステップ数選択） 

メッシュ表示 

ポスト表示の対象となる物理量を選択して、コンター、断面などのポスト表示 

である。 

10.3 入出力仕様 

プレ入力 

形状ファイル 

 IGES 

 STEP 

 STL 

 ADVENTURE_Tripatchフォーマットのパッチデータ 

メッシュファイル 

 FrontFlow/blue GF2形式のメッシュファイル 
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 ADVENTURE_TetMesh形式のメッシュファイル 

 MicroAVS UCD形式のメッシュファイル 

FrontFlow/blue GF2 フォーマットについては ASCII/Unformattedの両方に自動で対応

する。 

プレ出力 

解析モデルファイル 

 FrontFlow/blue GF2形式のメッシュファイル、境界ファイル 

 FrontFlow/blue解析制御ファイル 

ポスト入力 

計算結果ファイル 

 FrontFlow/blue GF2形式のメッシュファイル 

 FrontFlow/blue GF2形式の計算結果ファイル 

 MicroAVS UCD形式の計算結果ファイル 

ポスト出力 

画像データ 

 JPEG, PNG, BMP 形式の画像データ 

10.4 形状ファイルの読み込み・メッシュ生成 

FrontFlow/blueによる流体解析のためのメッシュがない場合、CADデータなどの形状デ

ータからメッシュを生成する。既にメッシュファイルがある場合は、このプロセスは省略

してよい。詳細はマニュアルのメッシュ生成の章を参照してください。 

10.5 メッシュファイルの読み込み 

メッシュ生成に成功した場合は生成したファイルを自動で読み込む。既存の解析用のメ

ッシュがある場合は、メッシュファイルを読み込んでそこに解析条件を設定して解析モデ

ルを作成することができる。 

ここでは既に四面体メッシュまたは六面体メッシュがあるものとする。 

メニューから File ⇒ Open Meshを選んで、入力するメッシュファイルを選択する。 
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図 10-1 メッシュの読み込み 

読み込まれたら 3D画面上にモデルが表示される。メッシュは境界面だけを描画する。 

プレ処理の時の TreeView の階層表示 

メッシュの情報、およびプレ処理で設定する内容は、階層的に整理されて、TreeViewに

表示される。 
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図 10-2 プレ処理の時の TreeViewの階層表示 

最上位階層に表示されている項目の説明は以下の通りである。 
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 Model：計算格子（メッシュ）の情報を表示する。その下の階層で、読み込んだメ

ッシュごとの境界面や座標系、境界条件の設定などを行う。 

 Solver : 解析制御のためのパラメータで、その下の階層 Turbulence、Static、Press

などで解析の詳細の設定をいくつかのグループごとに行う。ここで設定した内容は解析

制御ファイルに出力される。 

 Output：結果出力制御のパラメータを設定する。 

 ConditionPriority : 境界条件の優先順位を設定する。 

 Files : ファイルの出力先、ソルバを実行する場合の実行場所などを設定する。 

 Execute : ソルバの実行を行う。 

 Remote：リモート実行のための設定を行う。 

となっている。 

10.6 境界条件の設定 

初期状態ではすべての面がWallと設定されている。それ以外の境界条件を設定する場合

には、3D画面上で該当する面をマウスで選択し、右クリックして境界条件編集ダイアログ

を開く。 

複雑形状の内部の面を選択するには、外側の面をマウスで選択して移動させる、または

非表示にしてから、内部を選択する。 
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図 10-3 境界条件の設定 

境界条件の種類はプルダウンメニューで選択できる。境界条件の種類には以下のものが

ある。 

 Inlet（流入境界、流速入力可） 

 Wall（壁境界） 

 Symmetric（対称境界） 

 Cycle（周期境界） 

 Free（自由境界） 

 Moving Wall（移動境界、移動速度入力可） 

 Temp（温度境界、境界温度入力可） 

 Heat（熱境界、境界熱流束入力可） 

Overset条件で複数領域を結合させる場合には、ダミー境界のフラグをオンにする。 
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図 10-4境界条件の設定画面 

ふたたび境界条件編集ダイアログを開くか、TreeViewで該当する境界面をクリックする

と、設定されている境界条件の種類を確認することができる。 

流体力計算境界（Body）および標準以外のユーザーが定義した境界条件を設定する場合

は、TreeViewの Bodyまたは Customの項目から設定する。 

流体力計算境界の設定は、TreeViewのModelの項目の下の設定したいメッシュの下にあ

る「Body」の項目を選択して行う。3DViewの中で設定したい面を選択して、「追加」ボタ

ンを押すと、その面に流体力計算境界が設定される。 
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図 10-5流体力計算境界設定画面 

 

図 10-6流体力計算境界面の選択 
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図 10-7流体力計算境界の設定 

10.7 解析条件の設定 

解析条件の設定は、左側の TreeView から Solver およびその下位の階層の項目を選択し

て設定する。 

ここで設定する項目は、解析制御ファイル PARMLES3C、PARMLES3CT、PARMLES3X

の個々の変数に対応している。それら変数に関する詳細は、FrontFlow/blue ユーザマニュ

アルで確認してください。設定する一部の物理量は、無次元化されたものでなければなら

ないのでご注意ください。 

Solver 

ここでは計算モデルなどソルバに与えるパラメータの設定を行う。 
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図 10-8ソルバの設定 

ソルバの種類は les3c、les3ct、les3xから選択する。選択内容に従って解析条件の設定に

おいて編集できる項目が変化するので注意する。 

その他、この画面で設定する項目は 

 時間刻み 

 圧力方程式の収束判定値、最大反復回数 

 運動方程式の収束判定値、最大反復回数 

 無次元化のための代表的な値 

などである。 
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Turbulence 

ここでは乱流モデルに関する設定を行う。 

 

図 10-9乱流モデルの設定 

Static 

ここでは定常解析に関する設定を行う。 
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図 10-10定常解析の設定 

Press 

ここでは圧力方程式、キャビテーションに関する設定を行う。 
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図 10-11圧力方程式の設定 

Multiframe 

ここではマルチフレームの設定を行う。ここではマルチフレームの種類と加速度ベクト

ルの値を設定することができる。ただし FrontFlow/blue の Ver.7.1 の les3x の仕様に準拠

しているため、les3cおよび les3ctにおける 2つ以上のフレームの設定ができなくなってい

ることに注意する。 
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図 10-12マルチフレームの設定 

Heat 

熱輸送解析の設定を行う。 
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図 10-13熱輸送解析の設定 

Cyclic 

周期境界条件の設定を行う。 
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図 10-14周期境界条件の設定 

Option 

オプション項目の設定を行う。FrontFlow/blue のオプション変数のうち、すでにある項

目に関連するパラメータはその画面で設定できるようにしている。ここではそれら以外の

オプションパラメータの設定を行う。 
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10-15オプション項目の設定 

Relax 

境界条件の時間緩和制御の設定を行う。 

 

10-16境界条件時間緩和制御 

Memory 

メモリアロケーションの設定を行う。 

 

10-17メモリアロケーション設定 

JobCntl 

ジョブの制御の設定を行う。 
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10-18ジョブの制御の設定 

Overset 

オーバーセットの設定を行う。 

 

10-19オーバーセットの設定 
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Refiner 

解析モデルの細分の設定を行う。 

 

10-20細分の設定 

10.8 出力の設定 

出力の設定は、左側の TreeViewから Outputおよびその下位の階層の項目を選択して設

定する。出力インターバル、サンプリング点の設定などを行う。 

Output 

出力ファイルとインターバルの設定を行う。 

 

10-21出力ファイル設定 

Sampling 

サンプリングデータの設定を行う。 
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図 10-22サンプリングデータの設定 

10.9 境界条件の優先順位 

複数の境界面に含まれる節点について、どの境界条件を使うかについての優先順位を設

定する。TreeView の ConditionPriority を選択して設定画面を表示させる。優先順位を変

化させる境界条件を選択して、「上へ」ボタン、または「下へ」ボタンを押して、優先順位

を変化させることができる。 

規定値はあらかじめ適切な値が設定されている。上級者向けの機能であるため、変更す

る場合は注意すること。 
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図 10-23境界条件優先順位設定 

10.10 出力ファイルの設定 

モデルの名前、出力ディレクトリ、（同じメッシュで条件を変えて解析を行う場合の）解

析ケース名等を設定する。TreeViewの Filesの項目を選ぶと、設定用の画面が表示される。 

 

10-24出力ファイル設定 
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10.11 解析の実行 

REVOCAP_PrePostを実行している PC上で FrontFlow/blueを起動する。TreeViewか

ら Executeを選択すると、設定用の画面が表示される。 

 

10-25解析の実行 

図 10-26ソルバの実行 

10.12 リモート設定 

計算機サーバに解析モデルを転送してジョブを投入するなどの処理を行う。TreeViewか

ら Remote を選択すると、設定用の画面が表示される。詳細はマニュアルのソルバ実行方

法の章を参照のこと。 
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10-27リモート設定 

10.13 計算結果ファイルの読み込み 

計算が終了し、結果が REVOCAP_PrePost を実行している PC 上にあるとする。

FrontFlow/blue では結果の可視化にはメッシュと計算結果ファイルの両方が必要である。

ここでは順に読み込む。メニューの File ⇒ Open Result で計算結果用のメッシュファイ

ルを読み込む。 
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図 10-28ポスト用メッシュファイルの読み込み 

メッシュファイルの選択ダイアログのあとに、結果ファイルの選択ダイアログが表示さ

れる。 

 

10-29結果ファイルの読み込み 

計算結果ファイルが複数の時間ステップの結果を含む場合は、特定の時間ステップのみ

読み込むことができる。計算結果ファイルの選択をすると、そのヘッダーの情報を表示す
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る。 

 

図 10-30計算結果のステップ設定 

ヘッダーに計算した時間ステップが記述されている場合は、そこから読み込む時間ステ

ップを選び、STEP数に入力すると、その時間ステップの計算結果のみを読み込む。STEP

数に-1を入力すれば、ファイルの中の最初の計算結果を読み込む。 

10.14 ポスト処理 

FrontFlow/blue のポスト処理については、コンター表示、断面表示、ベクトル表示、等

値面表示に対応している。それぞれの機能については、ポスト表示の章を参照のこと。 

10.15 設定情報 

REVOCAP_PrePostをインストールしたディレクトリのFFbという名前のサブディレク

トリに FrontFlow/blue 固有のデータを保存している。 

 i386-mswin32 : Windows32bit環境での実行ファイル格納用ディレクトリ 

 x64-mswin64_100：Windows64bit環境での実行ファイル格納用ディレクトリ 

 i486-linux : Linux環境での実行ファイル保存用ディレクトリ 

 PropDB.ini : REVOCAP_PrePost用の初期設定ファイル 

 ffb_cx1000.template：東大生研スパコン CX1000で実行する場合のジョブスクリ

プト生成テンプレート 

 Remote_FFb_CX1000.ini：東大生研スパコン CX1000用リモート環境初期設定フ

ァイル 

初期設定ファイルは yaml 形式で記述する。 
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11 REVOCAP_Coupler 用マニュアル 

11.1 概要 

「イノベーション基盤シミュレーションソフトウェアの研究開発」で開発されているマ

ルチ力学解析モジュール REVOCAP_Coupler を用いて流体構造連成解析、および磁場構造

連成解析を行うためのプレ処理について説明する。 

流体(FrontFlow/blue)構造(FrontISTR)連成解析では、界面をインターフェイスとして、

磁場（REVOCAP_Magnetic）構造(FrontISTR)連成解析では領域をインターフェイスとし

て REVOCAP_Coupler による連成解析を行う。 

REVOCAP_PrePost では REVOCAP_Coupler のためのインターフェイスの定義情報

を作成する。 

ここで行う作業は、下記の図 11-1 マルチ力学解析プレ処理概略図における太線で示した

プロセスとなる。例えば、流体構造連成解析の場合では、構造解析用の解析モデルと流体

解析用の解析モデルから、マルチ力学における連成界面を選択して、REVOCAP_PrePost 

の中で界面のペアの生成および確認し、マルチ力学エンジン REVOCAP_Coupler のため

のファイルを生成して出力する。 
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図 11-1 マルチ力学解析プレ処理概略図 

11.2 対応するソルバ 

文部科学省次世代ＩＴ基盤構築のための研究開発「革新的シミュレーションソフトウェ

アの研究開発」にて開発された FrontSTR Ver. 2.02に対応する。 

「次世代ものづくりシミュレーションソフトウェアの作成プロジェクト」において開発

されている流体解析ソフトウェア FrontFlow/blue Ver.5.3に対応する。 

文部科学省次世代ＩＴ基盤構築のための研究開発「革新的シミュレーションソフトウェ

アの研究開発」にて開発された REVOCAP_Magnetic ver 1.0に対応する。 

「次世代ものづくりシミュレーションソフトウェアの作成プロジェクト」において開発

されているマルチ力学エンジン REVOCAP_Coupler Ver.1.3 に対応する。 

FrontISTR、FrontFlow/blue のプレ処理については、それぞれ上記のバージョンに対応

しているが、実際の流体構造連成解析を行う場合は、「次世代ものづくりシミュレーション

ソフトウェアの作成プロジェクト」において開発された最新のβ版 FrontISTR Ver.3.0 お
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用 

メッシュ 

流体解析

用 

メッシュ 

構造解析

用 

解析モデ

ル 

流体解析

用 

解析モデ

ル 
マルチ力学

用解析モデル 

 

構造解析ソル

バ（FrontISTR） 

流体解析ソルバ

（FrontFlow/blue） 

マルチ力学エンジン

（REVOCAP_Coupler） 

 

） 
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よび FrontFlow/blue Ver. 6.1 を利用していただきたい。磁場構造連成解析はソルバ側がま

だ対応していないため、ここで提供する機能はプレ処理のプロトタイプである。 

11.3 プレ・ポスト処理の手順 

REVOCAP_PrePostによる REVOCAP_Couplerのプリ処理の手順は、以下のとおり。 

 マルチ力学解析モデルの初期設定 

 連成インターフェース界面の定義 

 連成定義ファイルの出力 

である。以下ではこの手順に従って説明をする。 

11.4 入出力仕様 

プレ入力 

メッシュファイル 

 HECMW形式のメッシュファイル 

 ADVENTURE TetMesh形式のメッシュファイル 

プレ出力 

解析モデルファイル 

 HECMW形式のメッシュファイル 

 REVOCAP_Coupler解析ファイル 
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11.5 プロジェクトの設定 

新規にプロジェクトを作成する場合は、File メニューから New Project メニューを選択

してウィザードを起動する。既存のプロジェクトを開く場合は File メニューから Open 

Project メニューを選択する。ここでは新規にプロジェクトを作成する場合について説明す

る。 

まずはじめにプロジェクトの名前を入力する。 

 

図 11-2プロジェクト名の入力 

次にプロジェクトを作成するフォルダを選択する。 



121 

 

 

図 11-3フォルダの選択 

次に連成解析の種類を選択する。ここでは 

が選択できる。 

 

図 11-4連成解析の種類の選択 

次にそれぞれの解析についての計算格子ファイル（メッシュファイル）を選択する。 

 磁場構造連成 

 流体構造連成 
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図 11-5計算格子ファイルの選択 

設定が完了するとNextボタンが Finishボタンに変更になり、押すと作業が完了する。 

11.6 解析の種類の選択と解析条件設定 

本バージョンで対応しているのは、 

 流体構造連成解析 

 磁場構造連成解析 

の 2 種類である。この選択はプロジェクトの設定で行なっており、この選択によって解

析条件設定が異なる。ただし基本的なインターフェースは同様である。 
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Files 

 

図 11-6REVOCAP_Coupler のファイル設定 
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Surface Coupling 

 

流体構造連成解析の場合はこの項目で設定する。磁場構造連成解析の場合は Volume 

Couplingの項目で設定するが、インターフェースは同様である。 

11.7 解析モデルファイル出力 

Menuから File => Save Modelを選択すると解析モデルを出力することができる。 
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11.8 連成解析モデルのディレクトリ構造 

 

 

11.9 計算結果ファイルの読み込み 

メニューから File => Open Resultで計算結果ファイルを読み込む。流体構造連成の場合

は、FrontISTR の結果ファイル（MicroAVS UCD形式）、FrontFlow/blueの結果ファイル

（GF形式）をそれぞれ読み込む。 

11.10 読み込まれたデータの確認 

Treeviewの Data項目を選択する。その下の階層に、REVOCAP_PrePostに読み込まれ

たメッシュに付随するデータが列挙されている。データ名を選択すると、LogMessage画面

にデータ名の種類と対応している物理量の型が表示される。 

11.11 ポスト処理 

REVOCAP_Coupler の流体構造連成解析ポスト処理では、 FrontISTR および 

FrontFlow/blue のポスト表示を重ね合わせて表示する。詳細はそれぞれのそれぞれのソル

バのポスト処理機能を参照してください。 

ProjectRoot 

coupler Case1 

coupling.dat 

cpr.conf 

port 

MESH_CPL.PXXX 

rcap_mesh_XXXX 

runCoup.sh 

flow 

DATA 

Case1 

POST 

solid Case1 
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11.12 設定情報 

REVOCAP_Coupler に関する固有の設定は REVOCAP_PrePost をインストールしたデ

ィレクトリの RcapCouplerという名前のサブディレクトリに保存している。 

 PropDB.ini：REVOCAP_Coupler用の初期設定ファイル 

 ProjDB.ini：連成解析のプロジェクト初期値
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12 ADVENTURE_Solid用マニュアル 

12.1 対応するソルバ 

ADVENTURE Project(http://adventure.q.t.u-tokyo.ac.jp/)において開発された、固体静

解析のための有限要素法解析ソルバ ADVENTURE_Solid(Ver.1.2)に対応する。 

12.2 プレ・ポスト処理の手順 

REVOCAP_PrePost による ADVENTURE_Solid のプリ処理の手順は、以下のとおりで

ある。 

 形状ファイルの読み込み・メッシュ生成（またはメッシュファイルの読み込み） 

 解析の種類の選択 

 材料属性値の設定 

 境界条件の設定 

 解析条件の設定 

 解析モデルファイル出力 

である。解析モデルを出力後、ADVENTURE_Solidによる解析を実行することができる。

以下ではこの手順に従って説明をする。 

12.3 入出力仕様 

プレ入力 

形状ファイル 

 IGES 

 STEP 

 STL 

 ADVENTURE_Tripatchフォーマットのパッチデータ 

メッシュファイル 

 ADVENTURE_TetMesh形式のメッシュファイル 

プレ出力 

解析モデルファイル 
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 TetMesh形式のメッシュファイル 

 ADVENTURE_Solid制御ファイル 

 ソルバ実行用バッチファイル 

ポスト入力 

計算結果ファイル 

 ADVENTURE_Solid 計算結果ファイル 

ポスト出力 

画像データ 

 JPEG, PNG, BMP 形式の画像データ 

12.4 形状ファイルの読み込み・メッシュ生成 

FEM 解析のためのメッシュがない場合、CAD データなどの形状データからメッシュを

生成する。既にメッシュファイルがある場合は、このプロセスは省略してよい。詳細はメ

ッシュ生成を参照してください。 

12.5 メッシュファイルの読み込み 

メッシュ生成に成功した場合は生成したファイルを自動で読み込む。既存の解析用のメ

ッシュがある場合は、メッシュファイルを読み込んでそこに解析条件を設定して解析モデ

ルを作成することができる。 

メニューから File => Open Meshを選び、入力するメッシュファイルを与える。 

固体領域の境界面はメッシュファイルを読み込むときに自動的に抽出する。抽出した境

界面は Treeviewにおいてその親の固体領域の下の項目に Face01、Face02のような名前で

表示する。 
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図 12-1 メッシュファイルの読み込み 

Treeviewにおいて固体領域を選択すると、Custompaneにその固体領域の情報が表示さ

れる。 

 

 

図 12-2 固体領域の情報 
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12.6 解析の種類の選択と解析条件設定 

本バージョンで対応しているのは、 

 線形弾性解析 

 熱応力解析 

 弾性大変位微小歪み解析 

 弾性大変位大歪み解析 

 弾塑性解析 

 弾塑性大変位微小歪み解析 

 弾塑性大変位大歪み解析 

の 7種類である。 

解析条件の設定 

解析の種類の選択は Treeviewから「解析」の項目を選択して、Custompaneに解析の種

類の選択画面を表示させて行う。 

 

図 12-3 解析条件の設定 

解析の種類を選択したら、その解析のパラメータの設定を行うことができる。それぞれ

のパラメータの詳細については ADVENTURE_Solid のマニュアルを参照していただきた

い。 

解析条件設定 

Treeviewの「解析」の下の「解析設定」の項目を選択すると設定画面が Custompaneに

表示される。 
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図 12-4 解析設定 

増分ステップの設定 

解析の種類が以下の場合は、増分ステップの設定が可能である。 

 弾性大変位微小歪み解析 

 弾性大変位大歪み解析 

 弾塑性解析 

 弾塑性大変位微小歪み解析 

 弾塑性大変位大歪み解析 

このとき、Treeview の「解析」の下の「増分ステップ」の項目を選択すると以下の設定

画面が Custompaneに表示される。 
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図 12-5 増分ステップの設定 

12.7 材料属性値の設定 

REVOCAP_PrePost において固体領域に材料属性値を設定するには、最初に材料属性デ

ータベースにヤング率、ポアソン比などの材料属性パラメータの組に名前をつけて登録し、

その名前を固体領域に割り当てるという手順を取る。 

材料属性データベースの設定 

材料属性データベースにパラメータを登録するには、Treeview で「材料物性値」の項目

を選択し、Custompaneに材料属性データベースの設定画面を表示させる。 
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図 12-6 材料属性データベースの設定 

既に初期値としていくつかの材料属性値が登録されている。登録済み属性の選択プルダ

ウンメニューで材料の名前を選択して、パラメータの値を確認することができる。 
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図 12-7 材料属性データベースの設定 

また、ヤング率などの材料属性値に値を入れ（設定しないものは空白で構わない）、「材

料属性値を別名で追加」に登録名を入れて追加ボタンを押すと、データベースに追加する

ことができる。ここで与える登録名はそのまま ADVENTURE_SolidのMaterial名で使わ

れるので、半角英数字で与えなければならない。 

弾性静解析のときは、ヤング率、ポアソン比が必要である。更に、荷重の計算をする場

合は密度、熱応力解析の場合は線膨張係数、弾塑性解析をする場合は加工硬化係数、初期

降伏応力が必要である。必要としない材料属性は空白のままで構わない。 

材料属性値のデータベースは、以下のような CSVファイルで保存することができる。 

material,young,poisson,density,linearexp,thermal_conductivity,specific_heat 

unit,Pa,,kb m^-3,K^-1,W m^-2 K^-1,J kg^-1 K^-1 

Aluminum,70000000000,0.345,2690,2.50E-05,237,1.00E-06 

REVOCAP_PrePost アプリケーションの AdvSolid フォルダにある mat.csv というファ

イルが起動時に初期値で読み込まれる材料属性値のデータベースである。このファイルを

変更すると、デフォルトのデータベースが置きかえられる。 

材料属性値の固体領域への割り当て 

材料属性値データベースに登録されている材料属性を固体属性に登録するには Treeview

の「計算格子」の項目の下の固体領域の項目を選択する。このとき Custompane には材料
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属性設定用の画面が表示されるので、そこで登録されている材料属性値の名前を選択して

登録する。 

 

図 12-8 材料属性値の固体領域への割り当て 

12.8 境界条件の設定 

下に挙げる境界条件については、解析の種類によって設定できる項目が異なる。なおは

じめに解析の種類を選択してからでないと、目的の境界条件が設定できないので注意する。 

以下の境界条件の設定で与える名前はすべて半角英数で与えること。 

変位 

Treeview の「境界条件」の項目の下の「節点変位」、「面変位」、「面変位(垂直)」のいず

れかを選択する。 

以下では「節点変位」、「面変位」、「面変位(垂直)」それぞれについて説明する。 

「節点変位」では、マウスで指定した範囲の節点もしくは選択した面の節点に対する変

位の設定が可能である。 

「名前」の項目では、境界条件の名前を設定する。自動的に名前が入力できるが、変更

することができる。 
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「マウス指定範囲」のチェックボックスを ON にすると、マウスで節点の選択範囲を設

定できる。具体的には、Shiftボタンを押しながらマウスの左ボタンで 3DViewのモデルを

ドラッグすると、その範囲が選択状態になる。一方、面の節点を選択する場合は、3DView

で面をクリックすると、面の節点が選択状態になる。 

「x」, 「y」, 「z」方向の変位の大きさは各項目に入力する。それぞれのチェックボッ

クスを ONにするとその設定が有効になる。 

「追加」ボタンを押すと、選択した設定が有効になり「名前」で入力した名前の項目が

ツーの「節点変位」の下に追加される。この項目を選択すると、設定内容が表示される。 

「更新」ボタンを押すと、変更した値が有効になる。 

「削除」ボタンを押すと、設定は削除され、ツリーからも項目が消去する。 

 

図 12-9 節点変位 

「面変位」では、選択した面に対する変位の設定が可能である。設定項目は「節点変位」

とほぼ同様だが、設定の対象は面のみである。 
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図 12-10 面変位 

「面変位(垂直)」では選択した面に垂直方向の変位について設定できる。そのため入力す

る項目はスカラー値の変位のみである。 
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図 12-11面変位(垂直) 

荷重 

Treeview の「境界条件」の項目の下の「節点荷重」、「面荷重」、「面荷重(垂直)」のいず

れかを選択する。 

ここで「節点荷重」、「面荷重」、「面荷重(垂直)」それぞれについて説明する。 

「節点荷重」では、マウスで指定した範囲の節点もしくは選択した面の節点に対する荷

重の設定が可能である。 

「名前」の項目では、境界条件の名前を設定する。自動的に名前が入力できるが、変更

することができる。 

「マウス指定範囲」のチェックボックスを ON にすると、マウスで節点の選択範囲を設

定できる。具体的には、Shiftボタンを押しながらマウスの左ボタンで 3DViewのモデルを

ドラッグすると、その範囲が選択状態になる。一方、面の節点を選択する場合は、3DView

で面をクリックすると、面の節点が選択状態になる。 

「x」, 「y」, 「z」方向の荷重の大きさは各項目に入力する。それぞれのチェックボッ

クスを ONにするとその設定が有効になる。 

「追加」ボタンを押すと、選択した設定が有効になり「名前」で入力した名前の項目が

ツーの「節点荷重」の下に追加される。この項目を選択すると、設定内容が表示される。 

「更新」ボタンを押すと、変更した値が有効になる。 

「削除」ボタンを押すと、設定は削除され、ツリーからも項目が消去する。 
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図 12-12 節点荷重 

「面荷重」では、選択した面に対する荷重の設定が可能である。設定項目は「節点荷重」

とほぼ同様だが、設定の対象は面のみである。 
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図 12-13面荷重 

「面荷重(垂直)」では選択した面に垂直方向の荷重について設定できる。そのため入力す

る項目はスカラー値の荷重のみである。 
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図 12-14面荷重(垂直) 

 

重力 

Treeviewの「解析条件」の項目の下の「重力」を選択する。設定できるのは x、y、z方

向の 3成分の値である。チェックボックスを ONにすると設定が有効になる。 
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図 12-15 重力 

節点温度 

熱応力解析のときに設定可能である。設定できるのはすべての節点についての温度の値

である。 

 

図 12-16 節点温度 
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参照温度 

熱応力解析のときに設定可能である。 

 

図 12-17 参照温度 

注意 

それぞれの境界条件のマーカーは面を選択して境界条件を与えた場合には、その面と連

動して動くが、Lasso機能で範囲選択した場合には、必ずしも面と連動して動くとは限らな

い。 

12.9 出力設定 

Treeview の「出力」の項目を選択する。その下に「最終結果ファイルへ出力」と「増分

ステップごとに出力」という項目がある。後者の設定が可能なのは、解析の種類が 

 弾性大変位微小歪み解析 

 弾性大変位大歪み解析 

 弾塑性解析 

 弾塑性大変位微小歪み解析 

 弾塑性大変位大歪み解析 

の場合であり、そうでない場合は設定できない。 
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図 12-18 最終結果ファイルへ出力 
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図 12-19増分ステップごとに出力 
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12.10 解析モデルファイル出力 

Menuから File => Save Modelを選択すると解析モデルを出力することができる。 

12.11 解析実行 

Windows版のADVENTURE_SolidをREVOCAP_PrePostから呼び出すことができる。

ツリーにおける「ツール」の下にある「Execute」を選択する。モデルの保存をしていない

場合は、「保存場所」のボタンを押し、表示されるダイアログから保存するフォルダを選択

する。つぎに「モデル保存」ボタンを押す。そして「ADVENTURE_Solid 実行」ボタンを

押すと、解析を実行できる。 

Linux 環境において実行する場合は、保存したファイルを Linux 環境に転送し、実行フ

ァイルをシェルスクリプトとして実行する。 

 

図 12-20 解析条件の設定 

12.12 計算結果ファイルの読み込み 

メニューから File => Open Resultで計算結果ファイルを読み込む。まずメッシュファイ

ルを選択し、読み込む。つぎに結果ファイルを選択する。 
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12.13 読み込まれたデータの確認 

Treeviewの Data項目を選択する。その下の階層に、REVOCAP_PrePostに読み込まれ

たメッシュに付随するデータが列挙されている。データ名を選択すると、Custompane に

データ名の種類と対応している物理量の型が表示される。 

12.14 ポスト処理 

ADVENTURE_Solid のポスト処理では、表面コンター図、変形図、断面図に対応して

いる。それぞれの機能については、ポスト処理の項目を参照のこと。 

12.15 設定情報 

ADVENTURE_Solid に関する固有の設定は REVOCAP_PrePost をインストールしたデ

ィレクトリの AdvSolid という名前のサブディレクトリに保存している。 

 i386-mswin32 : Windows 環境での実行ファイル格納用ディレクトリ 

 i486-linux : Linux環境での実行ファイル格納用ディレクトリ 

 PropDB.ini : REVOCAP_PrePost用の初期設定ファイル 

 mat.csv:既定の材料属性値の設定ファイル
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13 REVOCAP_Magnetic 用マニュアル 

13.1 対応するソルバ 

文部科学省次世代ＩＴ基盤構築のための研究開発「革新的シミュレーションソフトウェ

アの研究開発」にて開発された REVOCAP_Magnetic Ver. 1.0に対応する。 

13.2 プレ・ポスト処理の手順 

REVOCAP_PrePostによる REVOCAP_Magneticのプリ処理の手順は、以下のとおり。 

(1) 形状ファイルの読み込み・メッシュ生成（またはメッシュファイルの読み込み） 

(2) 解析の種類の選択 

(3) 材料属性値の設定 

(4) 境界条件の設定 

(5) 解析条件の設定 

(6) 解析モデルファイル出力 

である。解析モデルを出力後、REVOCAP_Magnetic による解析を実行することができ

る。以下ではこの手順に従って説明をする。 

13.3 入出力仕様 

プレ処理入力仕様 

形状ファイル 

 IGES 

 STEP 

 STL 

 ADVENTURE_Tripatchフォーマットのパッチデータ 

メッシュファイル 

 ADVENTURE_TetMesh形式のメッシュファイル 

プレ処理出力仕様 

解析モデルファイル 

 ADVENTURE_TetMesh形式のメッシュファイル 
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 REVOCAP_Magnetic制御ファイル 

 ソルバ実行用バッチファイル 

ポスト処理入力仕様 

計算結果ファイル 

 MicroAVS UCD形式の計算結果ファイル 

ポスト処理出力仕様 

画像データ 

 JPEG, PNG, BMP 形式の画像データ 

13.4 形状ファイルの読み込み・メッシュ生成 

FEM 解析のためのメッシュがない場合、CAD データなどの形状データからメッシュを

生成する。既にメッシュファイルがある場合は、このプロセスは省略してよい。詳細はメ

ッシュ生成を参照してください。 

13.5 メッシュファイルの読み込み 

メッシュ生成に成功した場合は生成したファイルを自動で読み込む。既存の解析用のメ

ッシュがある場合は、メッシュファイルを読み込んでそこに解析条件を設定して解析モデ

ルを作成することができる。 

メニューから File => Open Meshを選び、入力するメッシュファイルを与える。 

固体領域の境界面はメッシュファイルを読み込むときに自動的に抽出する。抽出した境

界面は Treeviewにおいてその親の固体領域の下の項目に Face01、Face02のような名前で

表示する。 
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図 13-1 メッシュファイルの読み込み 

Treeviewにおいて固体領域を選択すると、3DViewにその固体領域の範囲が表示される。 

 

図 13-2 固体領域の範囲 

13.6 解析の種類の選択と解析条件設定 

本バージョンで対応しているのは、 

 非線形静磁場解析 

 時間調和渦電流解析 

の 2種類である。 

13.7 解析条件の設定 

解析の種類の選択は Treeviewから「解析設定」の項目を選択して、Custompaneに解析

の種類の選択画面を表示させて行う。「解析の種類」の項目から、 

 非線形静磁場解析 

 時間調和渦電流解析 

のいずれかを選択する。 
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図 13-3 解析条件の設定 
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解析の種類を選択したら、その解析の設定を行うことができる。以下の項目は解析の実

行時のオプションである。それぞれの設定の詳細については REVOCAP_Magnetic のマニ

ュアルを参照していただきたい。 

項目名 対応する実行時オプション 

HDDM設定 -hddm-{pc,eps,div,max-llop,log,no-log} 

HDDM強制電流密度補正 -coJo-hddm-{pc,eps,div,max-loop,log,no-log} 

部分領域解法(線形ソルバ) -l-sol-{pc,ic-shift,eps,div,log,no-log} 

部分領域解法(強制電流密度補正) coJo-l-sol-{pc,ic-shift,eps,div,log,no-log} 

ここで{x,y}とある場合は x,yのいずれかを意味する。 

13.8 非線形静磁場解析設定 

Treeview の「解析設定」の下の「非線形静磁場解析設定」の項目を選択すると設定画面

が Cusompaneに表示される。 

 

図 13-4 非線形静磁場解析設定 

項目名 実行時オプション 
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反復手法 -nl-method 

反復階数上限 -nl-max-loop 

収束判定値 -nl-eps 

発散判定値 -nl-div 

特性曲線 -nl-curve 

特性曲線補完方法 -nl-curve-ip 

Picard 逐次近似重み -nl-picard-weight 

13.9 時間調和渦電流解析設定 

Treeview の「解析設定」の下の「時間調和渦電流解析設定」の項目を選択すると設定画

面が Cusompaneに表示される。 

 

図 13-5 時間調和渦電流解析設定 

項目名 実行時オプション 

時間調和渦電流解析設定 -unit-magnetic-flux-density 

コイル角周波数 -unit-eddy-current-density 
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13.10 材料属性値の設定 

REVOCAP_PrePost において領域に材料属性値を設定するには、最初に材料属性データ

ベースにパラメータの組に名前をつけて登録し、その名前を領域に割り当てるという手順

を取る。 

13.11 材料属性データベースの設定 

材料属性データベースにパラメータを登録するには、Treeview で「物性データ」の項目

を選択し、Custompaneに材料属性データベースの設定画面を表示させる。 
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図 13-6 材料属性データベースの設定 
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「永久磁石磁化ベクトル」の選択によって、以下の設定項目の設定の可能、不可が決ま

る。 

 

 

 

 

磁化ベクトルデー

タファイル 

永久磁石領域B-H特性曲

線ファイル 

磁化ベクトルファイル 可能 不可 

形状定義ファイル 不可 不可 

非線形計算・磁化ベクトルファイ

ル 

可能 可能 

非線形計算・形状定義ファイル 不可 可能 

「永久磁石領域 B-H特性曲線ファイル」にファイルを指定している場合は、「特性曲線の

プロット」ボタンを押すと、以下のようにプロットを表示できる。 

 

図 13-7 B-H特性曲線のプロット 

既に初期値としていくつかの材料属性値が登録されている。登録済み属性の選択プルダ

ウンメニューで材料の名前を選択して、パラメータの値を確認することができる。 

設定項目 

永久磁石 

磁化ベクト

ル 



157 

 

 

図 13-8 材料属性データベースの設定 

また、各項目に値を入れ（設定しないものは空白で構わない）、「材料名」に登録名を入

れて「属性値テーブルをデータベースに追加」の実行ボタンを押すと、データベースに追

加することができる。ここで与える登録名は半角英数字で与えなければならない。 

必要としない材料属性は空白のままで構わない。 

材料属性値のデータベースは、以下のような CSVファイルで保存することができる。 

material,reluctivity,coil_type,coil,nonlinear,conductor,magnetization_type,magne

tization,magnetization_nl 

unit,m/H,,A/m^2,,S/m,,T, 
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iron,7.95774700E+05,rf,Jo,,7.70000000E+06,rf,M, 

air,7.95774700E+05,,,,,md,pmagnet.dat, 

coil,7.95774700E+05,md,coil.dat,,,nl_rf,M2,pmagnet_bh.dat 

outer,7.95774700E+05,,,,,nl_md,pmagnet_nl.dat,pmagnet_bh2.dat 

REVOCAP_PrePostアプリケーションのRcapMagneticフォルダにあるmat.csvという

ファイルが起動時に初期値で読み込まれる材料属性値のデータベースである。このファイ

ルを変更すると、デフォルトのデータベースが置きかえられる。 

13.12 材料属性値の固体領域への割り当て 

材料属性値データベースに登録されている材料属性を固体属性に登録するには Treeview

の「計算格子」の項目の下の領域の項目を選択する。このとき Custompane には材料属性

設定用の画面が表示されるので、そこで登録されている材料属性値の名前を選択して登録

する。 

 

図 13-9 材料属性値の固体領域への割り当て 

13.13 境界条件の設定 

以下の境界条件の設定で与える名前はすべて半角英数で与える。 
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Treeviewの「境界条件」の項目の下の「A x n = 0」の項目を選択する。境界条件の識別

子を「名前」に与える。設定画面が表示されている状態で、面全体を選択する。設定でき

ることは、選択した面に対する磁束密度を 0 にすることである。面の選択は 3DView にお

いてマウスを用いて行なう。「追加」ボタンを押すと境界条件が追加され、Treeviewの項目

の下に境界条件名の項目が追加される。 

 

図 13-10 磁場境界条件変位 

境界条件を削除する場合は、「削除」ボタンを押す。 

13.14 出力設定 

Treeviewの「出力」の項目を選択する。 
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図 13-11 出力 

「出力ディレクトリ」では、「ディレクトリ名」ボタンを押すとダイアログが表示され、

解析のためのデータを出力するディレクトリを選択すると、そのパスが項目に記入される。

項目にパスを直接記入することも可能である。 

「出力モデル名」において文字列を記入すると、出力されるファイルの拡張子以外のフ

ァイル名になる 

「出力単位」を選択すると、磁束密度、渦電流密度の単位を設定できる。 

13.15 解析モデルファイル出力 

Menuから File => Save Modelを選択すると解析モデルを出力することができる。 

13.16 解析実行 

Windows環境で設定し出力したデータファイルは、フォルダごとLinux環境に転送する。

フォルダの構成は変えないようにする。これはソルバがフォルダの構成を既定しているか

らである。 

Linux 環境において実行する。保存したファイルを Linux 環境に転送し、シェルスクリ
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プト (解析モデルの出力時に生成される拡張子が shのファイル) を実行する。 

13.17 計算結果ファイルの読み込み 

メニューから File => Open ResultでMicroAVS UCD形式の計算結果ファイルを読み込

む。 

13.18 読み込まれたデータの確認 

Treeviewの「データ」を選択する。その下の階層に、REVOCAP_PrePostに読み込まれ

たメッシュに付随するデータが列挙されている。データ名を選択すると、ログにデータ名

の種類と対応している物理量の型が表示される。 
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13.19 ポスト処理 

REVOCAP_Magnetic のポスト処理では、表面コンター図、変形図、断面図に対応して

いる。それぞれの機能については、ポスト処理の項目を参照のこと。 

13.20 設定情報 

REVOCAP_Magneticに関する固有の設定はREVOCAP_PrePostをインストールしたデ

ィレクトリの RcapMagneticという名前のサブディレクトリに保存している。 

 PropDB.ini : REVOCAP_PrePost用の初期設定ファイル 

13.21 その他 

付属しているサンプルデータは ADVENTURE プロジェクト

(http://adventure.sys.t.u-tokyo.ac.jp/jp/)で配布している ADVENTURE_Magneticに含ま

れているものを利用している。 
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14 REVOCAP_PrePost ソルバ実行チュートリア

ルとカスタマイズ方法 

14.1 概要 

それぞれのソルバの実行の仕方については、ソルバの使用説明書を参照のこと。

FrontISTR、FrontFlow/blue は基本的な手順を実行するスクリプトを 

REVOCAP_PrePost が生成する。ここでは、REVOCAP_PrePost から T2K その他の並

列計算機にジョブを投入する方法を説明する。 

14.2 操作手順 

REVOCAP_PrePost の Remote 実行設定画面では、 

 クラスタのホスト名 

 ログイン名 

 パスワード（または秘密鍵） 

 転送先のディレクトリ 

 転送プロトコル（ftp または ssh） 

 を与えて、クラスタへのファイルの転送を行うことができる。 

 さらに、 

 キューの名前 

 ジョブの名前 

 バッチ処理システム 

 MPI プログラム名 

 ノードあたりのプロセッサ数 

 ノード数 

を与えて、クラスタで実行するスクリプトを定義することができる。 

FrontISTR および FrontFlow/blue については、標準的な実行手順を記述したシェルス

クリプトが出力される。 

14.3 スクリプトのカスタマイズ方法 

一般に並列計算機環境で並列計算を実行するには、システムによってジョブの投入方法

なども異なり、またソルバによっても異なる。そのため、REVOCAP_PrePost ではこのス

クリプト生成部分は、マクロとしてユーザーが修正・拡張が可能なように設計されている。 

以下では、スクリプト生成マクロの作成方法について説明する。 

14.4 マクロの概要 

スクリプト言語 Ruby で書かれている 

いくつかの変数について、設定された値があらかじめ与えられている 

出力用のオブジェクトがあらかじめ与えられている 

14.5 マクロ内で有効な変数 

変数名 型 意味 FrontFlow/blue での例 

job 文字列 ジョブ名 FFB_ANALYSIS（キュ

ーシステムで区別するため

の任意の名前） 

queue 文字列 キュー名 q16 
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pre 文字列 ソルバ前処理プ

ログラム名 

pre.sh（ddrgbx.pl 等を呼

び出して領域分割するシェ

ルスクリプト） 

mpirun 文字列 MPI プログラ

ムの名前 

mpirun 

ppn 整数値 ノードあたりの

プロセッサ数 

4 

nodes 整数値 計算ノード数 4 

ncpu 整数値 cpu数 16（ppnと nodesの積） 

machines 文字列 マシンファイル

名 

machines 

solver_path 文字列 ソルバのインス

トールパス 

/opt/FFb/6.1/ 

solver_s 文字列 ソルバ名 les3x 

solver_p 文字列 並列ソルバ名 les3x.mpi 

modelname 文字列 モデル名 RevocapModel（プレポス

トが出力した格子ファイル

などの基名） 

post 文字列 ソルバ後処理プ

ログラム名 

post.sh（unifu.pl等を呼

び出して、可視化用のファ

イルを作成するスクリプ

ト） 

remotedir 文字列 リモート出力デ

ィレクトリ 

/home/username/FFbWo

rk 

workdir 文字列 リモート作業デ

ィレクトリ（出力

ディレクトリから

の相対パス） 

EXE/EXE.01 

output File クラスイ

ンスタンス 

出力用のオブジ

ェクト 

 

図 14-1ソルバ実行用マクロ内での有効な変数 

14.6 マクロの実際 

output オブジェクトの puts メソッドまたは print メソッドを使うと、マクロで定義さ

れた文字列がファイルに出力される。例えば、次のようにマクロを書くと、 

output.puts "#!/bin/sh" 

output.puts "#PBS -q #{queue}" 

output.puts "#PBS -l ncpus=#{ncpu}" 

output.puts "#PBS -l nodes=#{nodes}:ppn=#{ppn}" 

output.puts "#PBS -N #{job}" 

output.puts "cd #{remotedir}" 

output.puts "#{mpirun} -np #{ncpu} dplace -s1 #{solver_p} 2>&1 | tee –a log" 

実際は次のように出力される。 

#!/bin/sh 

#PBS -q q16 

#PBS -l ncpus=16 
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#PBS -l nodes=4:ppn=4 

#PBS -N FFB_ANALYSIS 

cd /home/username/FFbWork 

mpirun -np 16 dplace -s1 les3x.mpi 2>&1 | tee –a log 

FrontISTR および FrontFlow/blue 用の標準的なマクロが、それぞれ 

FSTR/batch.template 、FFb/batch.template にあるので、それを参考にして修正するこ

とを推奨する。 

14.7 マクロの設定方法 

実際の運用においては、並列計算機環境ごとにマクロを用意して、それを切り替えて使

うのが一般的だと考えられる。どのマクロを使うかについては、プレポストの初期設定フ

ァイル PropDB.ini ファイルに記述する。 
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15 REVOCAP_PrePostマクロ実行機能 

15.1 概要 

REVOCAP_PrePostのマクロ機能は、GUIを駆動する Rubyスクリプト言語から利用で

きる機能を、ユーザーが自由に拡張するための方法である。以下の機能が利用できる。 

 現在対象となっている RevocapMesh::MeshDBクラスのオブジェクトに対するメ

ソッドの呼び出し 

 FXRubyの機能を使った GUI機能の呼び出し 

 RevocapMeshモジュールの機能の呼び出し 

 その他一般的な Ruby言語の機能の呼び出し 

制御構造については、REVOCAP_PrePost が起動している Ruby の実行環境の文法に準

ずる（REVOCAP_PrePost Ver.1.6 では 32bit 版 Ruby Ver.1.8.7 および 64bit 版 Ruby 

Ver.1.9.2に準ずる）。 

この機能を利用すると以下のようなことが可能である。 

 繰り返し作業の自動化 

 メッシュの情報の取得 

 独自フォーマットファイルへの出力 

15.2 利用方法 

REVOCAP_PrePost からはマクロスクリプトを直接 GUI で入力する一行マクロ機能と、

あらかじめファイルに記述されたマクロを実行する機能がある。 

TreeViewからMacroと書かれた項目を選択すると以下のような画面が現れる。 

 
一行マクロにはスクリプトを記述して実行ボタンを押す、またはマクロファイルを選択

して、実行ボタンを押すと、マクロが実行される。戻り値は LogMessage 画面に表示され

る。 

スクリプトで利用可能な変数名とその型は以下の通り。 

変数名 型 説明 

@mesh RevocapMesh::MeshDB 対象となるメッシュのインスタンス 

@mainWin RevocapVisual < FXWindows FXRubyの FXWindowsクラスを継

承したメイン実行画面 

FXRuby の詳細は http://www.fxruby.org/ を参照のこと。RevocapMesh モジュールの

詳細はマニュアルを参照のこと。 
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スクリプトの評価値が LogMessage画面に表示されるので、標準出力に出力する puts等

の命令を記述した場合、実行結果ではなく puts コマンドの戻り値（通常 nil）が表示され

る。LogMessage画面には Rubyスクリプトにおける pコマンドで評価された値が表示され

るので、値を知りたい場合は putsを付けずにその値をそのまま記入すればよい。 

一行マクロ LogMessage 画面 

puts @mesh.getNodeCount >puts @mesh.getNodeCount => nil 

@mesh.getNodeCount >@mesh.getNodeCount => 525 

 

15.3 注意事項 

メッシュオブジェクトの状態が変わったことによる GUIの異常な動作が起こる可能性も

あるので注意する（例えば描画に必要な節点を削除したりした場合）。 

15.4 サンプル 

RevocapPrePost のインストールされたディレクトリの macro サブディレクトリにいく

つかのサンプルがあるので参考にするとよい。 

マクロファイル 説明 

MeshInformation.rb メッシュの情報を表示する 

OriginalFormatSave.rb 独自フォーマットでメッシュを保存する 



168 

 

16 REVOCAP_PrePost 設定ファイルについて  

16.1 概要  

REVOCAP_PrePost では、GUI の設定画面の初期値や、機能を選択するためのフラグな

どを初期設定ファイルで与えることができる。読み込んだ値は内部データベースの初期値

として使われる。一般的なソルバ設定パラメータの規定値などもこの初期設定ファイルで

与える。  

16.2 設定方法  

ソルバごとの初期設定は、PropDB.ini というファイルに YAML 形式で記述する。 

16.3 FrontISTR の場合の設定例 

--- 

### CNT ファイルに出力する情報 ### 

 

CNT: 

  VERSION: "3.3" 

  ECHO: false 

  SOLUTION.TYPE: STATIC 

  WRITE.VISUAL: true 

  WRITE.RESULT: true 

 

### STATIC ### 

 

STATIC: 

  Nonlinear: false 

 

### DYNAMIC ### 

 

DYNAMIC: 

  idx_eqa: 1 

  idx_resp: 1 

  t_start: 0.0 

  t_end: 1.0 

  n_step: 10 

  t_delta: 1.0 

  restart_nout: 0 

  gamma: 0.5 

  beta: 0.25 

  idx_mas: 1 

  idx_dmp: 1 

  ray_m: 0.0 

  ray_k: 0.0 

  nout: 10 

  node_monit_1: 0 

  nout_monit: 1 

  iout_list: [ 0, 0, 0, 0, 0, 0 ] 
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### EIGEN ### 

 

EIGEN: 

  NSET: 10 

  LCZTOL: 1.0e-8 

  LCZMAX: 60 

 

### HEAT ### 

 

HEAT: 

  DT: 0.0 

  ETIME: 3600.0 

  DTMIN: 1.0 

  DELTMX: 20.0 

  ITMAX: 20 

  EPS: 1.0e-6 

 

### SOLVER Control ### 

 

SOLVER: 

  METHOD: CG 

  PRECOND: 1 

  NSET: 0 

  ITERLOG: "YES" 

  TIMELOG: "YES" 

  NITER: 20000 

  iterPREMAX: 2 

  NREST: 10 

  RESID: 1.0e-6 

  SIGMA_DIAG: 1.0 

  SIGMA: 0.0 

  THRESH: 0.10 

  FILTER: 0.10 

  CONTACT_ALGO: ALAGRANGE 

 

### AMPLITUDE ### 

# AMPLITUDE: {} 

 

# ZERO 

 

### VISUAL ### 

 

VISUAL: 

  output_type: COMPLETE_AVS 

  v.method: PSR 

# surface_num は自動的に計算する 

  surface: 

    - display_method: 1 

      surface_style: 1 

      initial_style: 1 

  num_of_lights: 1 
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  position_of_lights: [100, 100, 50] 

  ambient_coef: 0.3 

  diffuse_coef: 0.7 

  specular_coef: 0.5 

  color_mapping_bar_on: 1 

  scale_marking_on: 1 

  num_of_scale: 3 

  font_size: 1.5 

  font_color: [1, 1, 1] 

  background_color: [0, 0, 0] 

  x_resolution: 800 

  y_resolution: 600 

# rotate の場合に必須 

  up_direction: [0.0, 0.0, 1.0] 

 

### PARTITION ### 

 

PARTITION: 

  type: NODE-BASED 

  method: KMETIS 

  depth: 1 

16.4 FrontFlow/blueの場合の設定例 

--- 

#### 乱流モデル ##### 

 

# 定常フラグ 

ITRANS: 1 

# 乱流モデルフラグ 

IMODEL: 0 

# 運動方程式解法フラグ 

IFORM: 2 

# 圧力方程式フラグ les3x での初期値にしている 

IPRESS: 1 

# マッハ数 for les3c 

FSMACH: 0.1 

# 分子粘性係数 

VISCM: 1.0e-5 

# 乱流プラントル数 

PRT: 0.0 

 

#### 無次元化 ##### 

 

# 代表長さ 

D000: 1.0 

# 代表速度 

U000: 1.0 

# 代表温度変動 

T000: 1.0 

# 参照温度 
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TREF: 300.0 

 

#### 熱輸送解析機能 #### 

 

# 熱輸送フラグ 

IHEAT: 0 

# 流体・固体連成熱輸送解析フラグ 

ISOLID: 0 

# ブジネスク近似フラグ 

IBUSNQ: 0 

# 流体部分の密度 

RHOF: 1.0 

# 固体部分の密度 

RHOS: 10.0 

# 流体部分の熱伝導率 

CONDF: 1.0e-1 

# 固体部分の熱伝導率 

CONDS: 1.0e-0 

# 流体部分の比熱 

CPF: 10.0 

# 固体部分の比熱 

CPS: 1.0 

# 熱容量 

RCPF: 0.0 

# 温度伝達率 

TDFF: 0.0 

# ダミーパラメータ 

RCPS: 0.0 

 

#### マルチフレーム #### 

 

# マルチフレーム機能制御フラグ 

NFRAME: 0 

 

# 加速度ベクトル NFRAME > 0 のとき 

# Ver.7.1 の les3x では成分だけ 

UFRAME: 0.0 

VFRAME: 0.0 

WFRAME: 0.0 

 

# 中間節点フラグ 

ISET: 0 

 

# オーバーセット機能制御フラグ for les3c 

JSET: 0 

 

#### キャビテーション #### 

 

# キャビテーション解析フラグ 

ICAV: 0 
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# キャビテーションモデルにおける蒸気圧 for les3c 

SIGMA: 0.0 

 

# キャビテーションのモデル定数 for les3c 

CGAS: 0.0 

CLIQ: 0.0 

 

#### 緩和 #### 

 

# 境界条件の時間緩和制御パラメータ 

TFINAL: 1.0 

 

# 境界条件の時間緩和制御パラメータ 

UFINAL: 0.0 

VFINAL: 0.0 

WFINAL: 0.0 

 

######## 

 

# スマゴリンスキー定数 

C: 0.2 

 

# 時間刻み 

DT: 0.06 

 

# 回転座標系の角速度 

OMEGA: 0.0 

 

# 定常計算の収束判定値 

EPSS: 1.0e-20 

 

# 定常計算の最大タイムステップ数 

NMAXSE: 100 

 

# SIMPLEC法の内部反復数 

NMAXSI: 1 

 

# 圧力方程式の行列ソルバ収束判定値 

EPSP: 1.0e-6 

 

# 圧力方程式の行列ソルバ最大反復回数 

NMAXP: 50 

 

# 運動方程式の行列ソルバ収束判定値 

EPST: 1.0e-6 

 

# 運動方程式の行列ソルバ最大反復運動回数 

NMAXT: 20 
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# タイムステップ数 

NTIME: 50 

 

# リスタートフラグ 

ISTART: 0 

 

# 出力ファイル制御フラグ 

IOUT: 0 

 

# 流れ場データ出力インターバル 

INTFSV: 0 

 

# 圧力場データ出力インターバル 

INTPSV: 0 

 

# 物体表面圧力場データ出力インターバル 

INTSFV: 0 

 

# 周期境界条件 for les3ct les3c 

# 流量 

QCCLF: 1.0 

# 圧力差 

PCCLF: 0.0 

 

# サンプリングデータ数 

NSMPL: 1 

 

# サンプリングデータタイプ 

LSMPL: [1] 

 

# データサンプリングする位置 

XSMPL: [0.0] 

YSMPL: [0.0] 

ZSMPL: [0.0] 

 

# 重力加速度ベクトル 

DIRGRV: [0.0, 0.0, 0.0] 

 

#### オプション #### 

 

OPTION: 

  # BTD 係数 for les3ct 

  COE_BTD: 0.1 

 

OVERSET: 

  NTIME: 2000 

  TINIT: 0.0 

  DT: 0.01 

  INTSV: 100 
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### les3c or les3ct or les3x ### 

 

SOLVER: les3x
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17 要素ライブラリ 

以下は REVOCAP_PrePost のメッシュ処理部で内部データとして保持することのでき

る要素の一覧である。この節点配列の順番で要素の登録、要素データの取得が行われる。

以下の記述で節点配列や接続行列の添え字は 0から始まる。 

接続行列は i番目の節点と j番目の節点の接続情報を表している。ただし利用者が直接こ

の行列を利用することはない。1次要素とみなしてつながっているときは±1とし、2次要素

とみなしてつながっているときは±2とする。 

符号は向きを表し、線要素、平面要素のみ有効である。 

辺、面情報は内部で保持している辺や面の順番を記述してある。各行は立体要素の場合

はその面、平面要素の場合はその辺の節点の接続情報が記述されている。（4面体要素なら、

それぞれの行が三角形要素の節点 IDの配列）面は外から見て反時計回りが正となるように

向き付けられている。 

17.1 線分1次要素(SEGMENT) 

接続行列 

0 1 

-1 0 

 

図 17-1 線分 1次要素 (SEGMENT) 

17.2 線分2次要素 (SEGMENT2) 

接続行列 

0 1 2 

-1 0 -2 

-2 2 0 
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図 17-2 線分 2次要素 (SEGMENT2) 

17.3 三角形1次要素 (TRIANGLE) 

接続行列 

0 1 -1 

-1 0 1 

1 -1 0 

辺 

1 2 

2 0 

0 1 

 

図 17-3 三角形 1次要素 (TRIANGLE) 

17.4 三角形2次要素 (TRIANGLE2) 

接続行列 

0 1 -1 0 -2 2 

-1 0 1 2 0 -2 

1 -1 0 -2 2 0 

0 -2 2 0 0 0 

2 0 -2 0 0 0 

-2 2 0 0 0 0 

辺 

1 2 3 
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2 0 4 

0 1 5 

 

図 17-4 三角形 2次要素 (TRIANGLE2) 

17.5 四角形1次要素 (QUAD) 

接続行列 

0 1 0 -1 

-1 0 1 0 

0 -1 0 1 

1 0 -1 0 

辺 

0 1 

1 2 

2 3 

3 0 
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図 17-5 四角形 1次要素 (QUAD) 

17.6 四角形2次要素 (QUAD2) 

接続行列 

0 1 0 -1 2 0 0 -2 

-1 0 1 0 -2 2 0 0 

0 -1 0 1 0 -2 2 0 

1 0 -1 0 0 0 -2 2 

-2 2 0 0 0 0 0 0 

0 -2 2 0 0 0 0 0 

0 0 -2 2 0 0 0 0 

2 0 0 -2 0 0 0 0 

辺 

0 1 4 
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図 17-6 四角形 2次要素 (QUAD2) 

17.7 四面体1次要素 (TETRAHEDRON) 

接続行列 
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図 17-7 四面体 1次要素 (TETRAHEDRON) 

17.8 四面体2次要素 (TETRAHEDRON2) 
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図 17-8 2次四面体要素 (TETRAHEDRON2) 

17.9 六面体1次要素 (HEXAHEDRON) 
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図 17-9 六面体 1次要素 (HEXAHEDRON) 

17.10 六面体2次要素 (HEXAHEDRON2) 
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図 17-10 六面体 2次要素 (HEXAHEDRON2) 

17.11 三角柱1次要素 (WEDGE) 

接続行列 

0 1 1 1 0 0 

1 0 1 0 1 0 
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図 17-11 三角柱 1次要素 (WEDGE) 

17.12 三角柱2次要素 (WEDGE2) 

接続行列 
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図 17-12 三角柱 2次要素 (WEDGE2) 
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17.13 四角錐1次要素 (PYRAMID) 

接続行列 
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図 17-13 四角錐 1次要素 (PYRAMID) 

四角錐 2次要素 (PYRAMID2)接続行列 
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図 17-14 四角錐 2次要素 (PYRAMID2) 
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